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Quick Start

Contract Setup

Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and
guotes window setup.

Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see
all of the contracts included in that window. Click to add a checkmark next to the contracts you want to see in
your drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

Once you have added the desired contracts to the contract setup “Selected” box you will next want to select
the months that you want to trade. If you change the month’s column to the “Nearest 2” selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the
contracts then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back
in.

& Contract Setup E]@
Available: Selected:
+ Currencies Description Symbal | Months )

= Energies Aussie Dollar B, Mearest
BH - Heating Cil British Pound 23] Mearest
CL - Crude Qil [jpit] Canadian Dollar GC Mearest
GCL - Crude Ol Eura F Currencies EE Mearest
GHO - Heating O éap‘?lf?esi‘“’eln EIJ_ HEC"TBS:
razilian Feal eares
GHU - Unleaded Merican Pezo =] Mearest
GNG - HH Natural Gias Mew Zealand Dollar BN MNearest
HH - Matural Gas Last-dap Ruzsian Ruble ER Nearest
HO - Heating Ol [pit) Swisz Franc g5 Mearest
HF - Matural Gas South African Rand e Mearest
HU - Unleaded (pit] Ethanal [pit] AC Mearest
NG - HH Natural Gias [pi) fyuse Dol [l PR
[F106 - HH Natural Gias mil'Y Hemng O BH Neares
[H - Heating D'I !T"NY Saybean il [pit] BO Mearest
Ob - Crude Ol milly Biritish Pound [pit] BFP Mearest
QL - Gasoline miky Brazilian Real [pit] BR Mearest
RT - RBOB Gaszoline Corn [pit) C Mearest
WS - Crude Ol Cacoa [pit) [ Mearest
5 Financials Canadian Dollar [pit] CD Mearest
o Grains Crude Oil [pit) CL Mearest
) Cotton Mo, 2 [pit] CT Mearest
# [] Indices DLl [pit) o Nearest
+ Meats 1S Dollar B33 Mearest
+ Metalz E-tini Eura Fx EY Mearest

+ Softs Euro Fx Currencies (pit) EC Mearest
Eura Dallar [pit] ED Mearest

{1 Mo, LIBOR ioit] Etd Mearest n i

e  Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and

click “OK”.

Account Summary

You can customize the "Account Summary" window by hiding the rows that you do not want to see.




Account Summarny E
Total
Profit/Loss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $£13.875.00
Balance
Cazh $ B4.765.00
Open FAL n.0a
Met Lig $ B4 7ER.00
Rate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summarny E
Total
ProfitfLoss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $13,875.00
Balance
Caszh $ 64 765.00
Open FAL n.0a
Met Lig $ 64.765.00
R ate
all Currencies
| Column Setup. ..
Fonk...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.

[ e
m Account Summary = @
Colurmn izibility
Open PrL Hidden v
Fealized P/L
Total PAL Esl’dma'
Cash Hidden
Open PAL Tarmal
Met Lig Mormal
Fate Marmal
()4 l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.
Total P/L shows the total P/L for both the Open and Realized P/L.

Quick Start
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Account Summan

Profit/Loss
Open F/L
Realized P/L
Total FAL

» | all Currencies

Tatal 5D
000 0.00
-4 55.00 -55.00
-4 55.00 -55.00
R0167.50

Fork...

Column Set - 0.00
all Currencies | B01E7.50

Export ko C5V.

1

CHF

0.00
0.00
0.00

003
0.00
009

JET3

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in Global Zen Trader. This gives the trader an
opportunity to confirm the order before the order is sent for execution. This feature is optional and is turned on by

default.

E OECTrader Demo

File  Account

Symbol | HBo

ECUE
ESUE

Crders

Abbreviated COrder Enkry

Cornrunications

Cuotes  Wiew

Reports

Turbo Order Enkry
Rapid Order Enkry

Depth OF Market Order Entry

Ctrl+1
Ctrl+2
Ctrl+3
Ctri4+4

Setup

Toolbox

b

Crder Defaules, ..
Clear After Submit

Pos |  § Total PAL

5 $550.00
10 $2.625.00

[ Average Position

Mew Order
Cancel Order

Conkrack Setup...
Account | Confirmations
DEMO25220 Motifications
Shove Cancelled Crders
Show Rejecked Orders
[ i
o =
u x e |
m Order Confirmation

3

Aocount: DEMO25330
Send BUY 5 BAUG MET?

| ok

[ Cancel

Notifications



Quick Start

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel

Failed".

m OECTrader Demo

File  Account

Symbal | #HBa

ECUG
ESUE

Average Pozition

Account
DEMO25830

Crders | Communications Vieww  Reports  Setup Toolbox  Help 0
Abbreviated Order Enkry Chrl+1
Turbo Order Entry Ckrl+2 Poz| % Tatal PAL
Rapid Order Enkry Chrl+3 5 $300.00
10 $2,750.00
Depth OF Market Order Enkry Chrl+4
Order Defaults, .
Clear After Submit
Cankrack Sefup...
Confirmations Surhbinl Prre Last Croc

Motifications

Show Cancelled Orders
Show Rejected Orders

| New Fil
Modify or Cancel Failed

m OECTrader Demo

-,

Cloze

\_‘l) & fill [100=31 298, 25] haz been added inta Order #733150

Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order

accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.

Decide if you would rather hear a sound or see an alert box.

To access Sound Alerts:

a. Communications > Sound Alerts
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m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fill Received <default: Alert Bow
k odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [zzued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

To configure:

a. Highlight the channel that you want to assign the sound to.

b. Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files
are located: (C:/WINDOWS/Media)

C. Hit "Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you
want sounds only.

e. Hit "OK"



Overview
File

Logon

When disconnected from the Global Zen Trader, selecting Logon will present a dialog box to connect. This will
require your Username and Password. As an option you may also select for the Global Zen Trader to Auto
Reconnect in the event you lose connection from the OEC servers. Once the Username and Password have been
filled in click Logon to connect or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uszer Mame:  UserTest

m OECTrader Demo Password: | =]
File | Accounk  Orders
Werzsion: | 3.1.0.4
| Logan
Avg. futo Reconnect
Exit [ Logon ] ’ Catizel
Logoff

To logoff the Global Zen Trader, select File then logoff. This will present an Exit Confirmation dialog box recapping
your daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
Global Zen Trader on your screen however it will be logged off from the servers.

m OECTrader Demo

File | #Account  Orders

| Logaoff | Avg.
Exit Logaff

Exit
This feature will provide the same functionality as the Logoff and in addition it will close the entire Global Zen Trader
application.
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m OECTrader Demo
File | Account  Orders
Logoff A
Exit |r
m Exit Confirmation
1 Wiorking Orders
1 Filled Drders
Accaunt Symbal | #Prev | #Bought | #5aold | Met Pos
DEMOZ5830 BCUG ] 1] 0 ]
DEMOBE3SS BCLG -h 1] 0 -h
DEMOZ5830 ESLG 10 1] 0 10
DEMOBE3595 ESLUE 20 20 1] 40
E =it l [ Stay Logged On
:_Acc ount

m OECTrader Demo

File | Account | Orders  Communications

Average Positions

Sy Detailed Positions Id
ECLI 1]
ESL Select Account L

Accounk Filker, .

Average positions
Displays the average positions open on each specific contract that has been traded.
In order to go flat in a specific contract:

a. Inorderto go flat in a specific contract, left click on the position and click on "Exit F2". This will immediately
transmit a market order for the contract selected to flatten the position.

b. In order to go flat in all current contracts with open positions left click the "Exit Al"l. This function will
immediately transmit a market order to exit all contracts with open positions.
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Average Posibions LA
Symbol | HBought | Awg BuyPrice | #50ld| Awg Sell Price | MetPos|  $ Total PAL| | E¥IEFS
Exit all

ESLIE 20 1293.75 1] .00 20 F250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

Detailed Positions ERER|
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Fealized PAL Open P/ Tatal PAL || EEF2
Exit &l
ESLE 1293.75 0.00 20 noouso 2a0.000sSD 28000150

Select Account

If trading multiple accounts, left click the upped area where it says "Account: DEM0O85399", choose the account you
would like to trade. This same function can be accessed by the keyboard function CTRL-A.

=

Accounk: DEMOSSZ99

DEMOZ5830
DEMOB5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the Global Zen Trader.

Select Always Show Selected Account and the Global Zen Trader will automatically display the orders of the
selected account.

m Account Filter Dialog M

DEMOZ5830
DEMOB5333

Alwayz Show Selected Account

| Toogleast || ciearan || ok || Cancel
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prd ers

m OECTrader Demo

Symbaol | HBo

BCUE
ESUE

<

-.-’-'-.v.erage Position

Account
DEMO2R830

File Account | Orders Carmmunications Quotes  Wiew

Repi

Abbreviated Order Enkry Chrl+1
Turbo Order Enkry Chrl4+2
Rapid Crder Enkry Chrl+3
Depth OF Market Order Enkrw Chrl+4

Crder Defaules, ..
Clear after Submit

Contrack Setup...
Confirmations

Motifications

Show Cancelled Orders

Show Rejected Orders

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform

Side kdarkeat Selection

(%) Buy Cluaritity S ymbol

O Sel . | |Esus ™
Order Spacs

Type: | Market v Flag: | Mone

| BLMT F3 | | B-MKT F4 |

New Order F8 | | SLMTF5 | [ 5-MKT Fé |

Template:

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently

c. Allows you to load and save orders from excel.

10




Overview

Turbo Order Entry (4 |
Account Side [ty Symbol | Type Flagz Price | Prce? | Statuz

[+] DEMO25830 Buy 4 BALE b arket Mone Ready to zend
DEMOZ5830 Sell 15 ESUB Lirnit GTC 1.60 Feady to zend
DEMOZ5330 Buy 4 BEUB b arket Mone Ready to zend
DEMOZ5330 Buy 15 EDUB b arket Mone Ready to zend

B 2]

Mew Order Transmit B-LMT B-MKT S-LMT S-MKT | Submit &l Delete Clear | (& Load

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry [
Auta Factor Settings

.

Bup StopLimt (0.00 (2] 0.00 2] Stop 1295.75 [ Limit 129575 4]
Sell Limit 000 2 Limit 1295.75 |2 Sell Limit
Cluantiby Suyrbol
0 w| [ESUE " Last 1295.75
= . Size =

Bid 129550 . Sell Bid
Auta Factor Settings
Buy Limit 000 2] Limit 1295.75 (2
SellStop Limit 0.00 (3] 000 2] Stop1295.75 3] Limit 129575 |3

Depth of Market Order Entry (DOM)

Allows you to launch DOMs from here

[N

1
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Depth Of Market Order Enty oD
Symbol: |BAUE v | [Launch ] Spmbok | || Lauwen
Symbok | |»| Lewch | Spmbok | ] Launck
Symbok | |»| Lewch | Spmbok | ] Launck
S yrobol: Launch | Symbok Launch
Symbok | |v| Lewch | Spmbok | [v] Lounck

Order default

Can create default orders for each account what will appear when a new order is being placed after clicking on NEW
ORDER in the AOE.

r Order Defaults W
Account | DEMO25830 |
Drefaulk Order for

Buy/Sell: | By &I
S ymbal: | ESLE BI
OrderType: Market v

[ ]9 ] [ Cancel ]

Contract Setup

1. Every contract that appears in the SELECTED box will appear in the drop boxes
2. Can add market and groups
3. Can customize each contract

4. Give each contract a default quantity (QTY).

5. Change the contract months that are traded.

Confirmations

12



Overview

As a safeguard a trader can turn on the "Confirmations" feature in Global Zen Trader. This gives the trader an
opportunity to confirm the order before the order is sent for execution. This feature is optional and is turned on by

default.

m OECTrader Demo

Order Confirmation

7

Account: DEMO25830
Send BUY 5 BAUG MET?

| ok

[ Cancel

Notifications

File  Account | Crders | Communications  Quotes  Wiew  Reports  Setup Toolbox  t
Abbreviated Order Enkry Zhrl+1
Symbal | HBo Turbo Crder Entry Chrl+2 FPosz| % Tatal PAL
BCUE Rapid Order Enkry Chrl+3 3 $3250.00
ESLE 10 $2.625.00
Depth OF Market Order Entry Chrl+4
Crder Defaulks. ..
.. L After Submit
Average Position Far ATter submi
Conkrack Setup...
Account | Confirmations 3 | Mew Order
DEMO25830 Natifications » Cancel Order
Shove Cancelled Crders
Show Rejecked Orders
[l i [
fam -1

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation

failed.
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m OECTrader Demo

File  Account | Orders | Communications  Quotes  Yiew  Reports  Setup Toolbox  Help 0
abbreviated Order Entry Chrl+1 |
Symbol | #Eo Turbo Order Enkry Chrl+2 _P.;.S 4% Toatal PAL
EEHEE Fuapid Order Enkry Chrl+3 'Ig $2$§gggg

Depth OF Market Order Enkry Chrl+4

Crder Defaults, .,

.. w | After Submik
Ayerage Position =ar ATter SUbm

Conkrack Setup..,.

Account Confirmations ' e | ast Cone

DEMOZ5630 | Motifications 1o hewr I
Show Cancelled Orders Modify or Cancel Failed
Show Rejected Orders

.

m OECTrader Demo

\ 12 & fill 100231 298 25] has been added inta Order #733150

Cloze

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account Order # | State Side [ty | Symbal Ay Price
DERMOZ5530 778834  Cancelled By 0/3 ESUB
DERMOB5399 780529 Completed By 20420 ESUG 1297.75
DERMOB5399 783150 Completed Sell 10410 ESUG 12958.25
DEROZ25830 783258 Rejected By 000 BCUB

Communications

Sound alert

e  Customize different alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

®  You can customize with any .wav file or our programmed files which come with the software

e  Decide if you would rather hear a sound or see an alert box.

14
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m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fill Received <default: Alert Bow
k odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [zzued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

Message History
®  See your message with the broker you spoke with, when about what and what the broker said.

e  Click on view to view within the software or PDF to export into a PDF file or Excel to export into a .exe file

¢ Message History

File
Begin Date: End Date:
08/23/2006 00:00  [»| | 08/23/2006 2353 [+ | view | [ _POF | [ Escel |
H 4 Page1of1 bk M =]
Chat History for DFormica57
Time From -> To M
08/23/2006
15:28:33.607 DFormicas? -= Danield  |Hello I have a question.
15:28:47.170 DFormicas?y -= Danield | What is the current symbol of th
15:29:13.513 Daniels -= DFormicas? | The current symbaol for the mini =
15:29:23.763 DFormicas? -= Danield | Thank you !
15:29:35.730 Danield -= DFormicas? | Your Welcome!

15
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Chat/Research Windows

Close/Open

Click on the RESEARCH options; if the option has a check next to it then it's available to view; if it doesn’t have
a check then it isn’t available to view.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD Order would need credit of 60712.52
15D [zash available iz 37862 48 150]

Click on the CHAT option. If it is already checked it will uncheck the CHAT option and it'll be unavailable to
chat.

Chat

3:28:36 PM to Daniel&:Hello | have a question. A | | Darield
3:28:50 PM to DanielA\what iz the current symbol of the
rriti SP 500 7

32917 PM Danieli: The current spmbaol for the mini S&P
A00 iz ESUR

D-0-F Dl b D mmanllA - Tl-ande oman |l

Quotes

16
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File  Account  Orders  Communications

Average Positions

Symbal | #Bought | Avwg Buy Price | #5old

BCUG 0 0.00 0
ESUE 0 0.00 0

Awerage Positions | Detailed Positions |

Open Orders

Account Order #| State By

<] 1

Abbreviated Order Enty
Side hdarket Selection
) Buy Quantity Symbal
O el 0 v |Zveos
Order Specs
Type: | bl arket &I Flag: [

Quotes | Yiew  Repaorks

Setup

Add Market

add Market Group
Remove Market
Remaove All Markets

Insert Blank Line

Movwve Up
Mave Dawn

Sort By Alpha

Cuskom Price Format
Fonk...

Rename...

Add Price Alert
Remove Price Alert

Wi Price Alerts, ..

[l |
Chart

Column Setup. ..

Expork ko C5V...

Add Remove Market and Group

Add Market
a. Add a market by contract
b.  Pit contracts are snap-shots

c.  Electronic contracts are streaming

m Market Selection

Contract Title: | BALIG

[ ]9 ] [ Cancel

X]
]
|

Add Market Group
a. Add an entire Market Group

b. Nearest month or all months

Overview
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m Market Group Selection
Group Title: b onths:
Curmencies w MHearest 1 | w

k. ] [ Cancel

Remove Market

Remove the highlighted market from the Quotes window.

Remove All Markets

Remove all markets from quote window.

Customize Appearance

Quotes

Symbaol Last | Lastol Bid| BidSize Bzl | AszkSize ||
E5SLG 1297.50 1 1297.25 R2T 1297.50 340 1
MNOUE 1867.00 13 1567.00 13 1557.25 251 1
ERZUE E99.2 2 £99.1 K1l £99.2 3

ZBLG 11000 1 11000 1477 110m 276

ZHUEB 106 305 a0 106 30.0 3249 106 305 728 10
ZrE0E E23.3 1 G204 3 215 1

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

Move up/Move Down
Move the highlighted contract up/down

Sort by Alpha

Sort all the contracts in the Quotes window in alphabetic order
Customize Format

Custom Price Format
Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.



m Price Format
BSLE

Default Format Default Mulipler
wiZ * 000000
wid *0.00001
/8 *0.0001
w16 *0.00
w3 *00
/B4 01
w128 “1
n/256 10
0 100
na #1000
Q.00 *10000
0.oon *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000

Apply ] [ Cancel

Font

Customize the font of your Quotes window.

o~

Font
Eont: Faont style: Size:
kicrozoft Sans Senf R egular a [ K ]
) Microsoft Sans Senf & ]| | Fegular a ”
(} Monotype Corsiva [talic: 9
(} M5 Outlook Buold 10
{} M5 Reference Sans 5| | Bold ltalic 1
g M5 Feference Specia 12
Y Boli 14
} Palating Linotype M 15 M
Effects Sample
[ ] 5trikeout
AaBbv
[ ] Underline sBBYYZ2
Script:
|'W'estern B]
Rename...

Ability to rename the title of the Quotes window.

Overview
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P . Quotes T est
Custom name of Quote... Symbol Last LastVol Bid | BidSize
Please enter new hame: ESUG 1297.75 10 1297.50 528
’ GALIG 76.16 4 76.16 7
[uates Test GCLI6 90.11 7 90.17 17
GELI6 127.81 3 127.87 22
Ok, ] [ Cancel GG 3.674 1) 3.6713 240
6506 809.3 G 309.7 21

Quote alerts

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.

-,

m OECTrader Demo

Alert Price1293.00 : ) <=
O =

1 Auto
Alert Test [optional]
ESUE went below or equal ta 1293.00

(] 4 l [ Cancel

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price
Alert".

View Price Alerts...

View all current price alerts. To remove one alert, select one alert and hit "Remove". To remove all alerts, just
hit "Remove All".

20



Price Alerts

Market | Frice
ESUE ¢=1298.00 ESUG went below or equal to 1238.00

IJzer Meszage

Edit

Femove Remove All

View
Yiews | Reports  Setup  Toolbox

Lock Windows |

Show Tabs
Layauk 3
Positions 3
Account Surnmary
Cpen Orders
Completed Orders —
Order Tickets »
Cuokes
Depth of Market r
Charts k
ommunications 3 =

Lock/Unlock Windows

stay in the current location and are not configurable.

1.
2.
desired.
Layout
Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

Overview

Click on View, and then LOCK WINDOWS. When a check is next to LOCK WINDOWS then the windows will

If there isn't a check next to the LOCK WINDOWS option the windows are unlocked. Please configure as

21
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Save Layout
Enter name af layout;

MuLlayout]

[ Ok, ] [ Cancel

Once the layout is saved it will be available under View > Layouts.

Wiews | Reports  Setup Toolbox  Help Cpen a Live Accounk
Lock Windows
Show Tabs
| Layauk r | Save. ..
Positions 3 Delete. ..
Account Summaty Restore Default Layout
Cpen Orders MyLavoutl
Completed Orders —_——————
Crder Tickets 3
Quates Arccount Order #
DEMOBE399 7a0529
Depth of Market r — DEROBR399 F83150
harts , DEMOZ5830 7a3258
DEMOB5399 Ta3704
Cornrnunic ations » b
Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".
Configure windows

Positions Window

Ability to toggle back and forth from Average Positions to Detailed Positions.

Wiews | Reports  Setup  Toolbox  Help Cpen a Live Accou

Lock Windows
Show Tabs Tatal PAL

Layout » SF2.00Ush
-288.00 USD
| Pasitions » m Average Positions
Account Surmmary Detailed Positions
Open Orders

Other Windows

22
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Account Summary, Open Orders, Completed Orders, , Order Tickets, Quotes, Depth of Market, Charts or
Communications.

Access Reports

Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.

Daily Fills

Shows the dalily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire OEC population. These
messages are important details from the broker involving major Futures issues.

Order Details

Provides a detailed description of each trade made and the necessary identifications for each detail within the
order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Provides the list of open orders that exist with in that account.

Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of OEC Trading options.

Action Keys -
File
Logaon
L ogiff
E xit
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Entry b adifiers:
Rapid Order Entry ]
Drepth Of Market Order Entryp Cul [] shift [] Al

Contract Setup Key:
Clear &fter Submit

1 | | Reset
Turn ofn Mew Order Confirmation -

Restare Defaulq [ Ok ] [ Cancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and all
the contact info for customer service and support.
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-,

rm Quick Start = @

HEE N BN L 1
open e cry"

Welcome to Open E Cry's direct access trading software.

We encourage vou to vizit our quick start guide and in depth uzer's
guide.

If vou have any questions please visit our Live Help or call 800-520-
5308 or 814-792-2590,

A link to the quick =tart guide will be available under the "Toolbox™ menu
of the goftware for future reference.

[wl Show an startup

Toolbox

Contract List
Display the Open E Cry's Contract List web page with your default browser.

URL.: http://www.openecry.com/platforms/available.cfm

Contract Margins
Display the Open E Cry's Contract Margins web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/margins.cfm

Contract Specs
Display the Open E Cry's Contract Specifications web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/contract.cfm

Glossary
Display the Open E Cry's Glossary web page with your default browser.

URL.: http://www.openecry.com/traderstoolbox/glossary.cfm

Help

Contact Us

25
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Display the Open E Cry's Contact web page with your default browser where you can direct questions/comments to
our staff.

URL: http://www.openecry.com/company/contact.cfm

About

Displays the current information of the platform that the trader is currently running.

rm About

OECTrader Dema

] Nl L B Version 31.0.5

@ 2006 Open E Cry, LLC

bt |
0 p e n e c ry All rights reserved

Open Live Account (DEMO ONLY)

Demo Only

Display the Open E Cry's Online Application with Electronic Signature web page with your default browser.

URL.: https://www.openecry.com/openaccount/applyonline.cfm
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File

Logon

When disconnected from the Global Zen Trader, selecting Logon will present a dialog box to connect. This will
require your Username and Password. As an option you may also select for the Global Zen Trader to Auto
Reconnect in the event you lose connection from the OEC servers. Once the Username and Password have been
filled in click Logon to connect or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uszer Mame: |LserTest

m OECTrader Demo Password: | ]
File | Account  Orders
Wersion: | 3.1.0.4
| Logan
g, Auto Beconhect
Exit [ Logon l [ Cancel
Logoff

To logoff the Global Zen Trader, select File then logoff. This will present an Exit Confirmation dialog box recapping
your daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
Global Zen Trader on your screen however it will be logged off from the servers.
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Orders

File | &ccounk

Logan

Ay,

Exit Logaff

Exit Confirmation

Wharking Orders
Fillod Ciclers

Account Symbol
DEMO25830 ECUE

DEMOZ5820 ESUE
DEMO85333 ESUE

#Bought | #Sold| MetPoz
1] 1] 3]

1] 1] 10

20 1] 40

E xit

] [ Stay Logged On

Exit

This feature will provide the same functionality as the Logoff and in addition it will close the entire Global Zen Trader

application.




m ﬂ!! | raaer Bemn

File | #Account  Orders

Logan

Logaff A

5

!

Wworking Orders
Filled rders

DEMOZ5830 BCUE

DEMOZ5820 ESUE
DEMO85353 ESUE

Aocount | Symbol | #Prev| HBought| #5old| MetPoz|

5 0 1] 5
10 0 1] 10
20 20 1] 40

E xit

] [ Stay Logged On

File
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Average positions

Displays the average positions open on each specific contract that has been traded.

In order to go flat in a specific contract:

In order to go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately

a.
transmit a market order for the contract selected to flatten the position.

b. In order to go flat all current contracts with open positions left click the Exit All. This function will immediately
transmit a market order to exit all contracts with open positions.

Symbol | #Bought | Awg BupPrce| #Sold | Awg Sell Price | Met Pos $ Total PAL
BCLE 0 0.00 il q0.03 -5 FE0.00 | | Exit Al
ESLIE 20 129375 0 0.00 20 $250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

4| »
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Realized P/L Open P/ Total P/L
ECUE .00 a0.03 -5 noouso 11000 0sD 1000 USD | Exit Al
ESLIE 1293.75 0.00 20 noouso 25000050 25000150

Select Account
If trading multiple accounts, the trader has the ability to switch from one account to the other to trade.

Left-click the upper right area where the current account number is being displayed. Or, Keyboard function
CTRL-A

a.

b.  Check the account that you want to trade.

BEX

Account: DEMOS5399

DEMOESE30

DEMOR5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the Global Zen Trader.
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Select Always Show Selected Account and the Global Zen Trader will automatically display the orders of the
selected account.

Account Filter Dialog = @

DEMOZ25230
DEMO25339

Alwanz Show 5elected Account

| Toggedl || cCearan || o0k || Cancel
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Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

" { . }
Side hdarket Selection
() Buy Quantity Symbol
1] ESUE
Order Specs
Type: | Market v Flag: | Mone v
| B-LMT F3 | | B-MKT F4 | Template: v
| Mew Order Fa | | 5-LMT F5 | [ 5-MKT FE |

Side

Buy

Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is
called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery

date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol

Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type
Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
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Limit (LMT)
Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has

been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commaodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:

1. They are activated when the price reaches the order level
2.  They become MKT orders once they are activated

MIT orders are used differently from STPs.

Buy MIT below the MKT price to establish a long position.

Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.
Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique
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allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag
Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (IOC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a. i.e., BUYthe ES at5 QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

b. Traders can have as many Templates as desired for quick an easy trading made for the trader.
You can have different template for the same contract.

d. DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a. Inorderto EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

b. Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time
b.  Can transmit multiple orders concurrently

c.  Allows you to load and save orders from excel.

34



Orders

Turbo Order Entry (AR
Account Side Gk | Symbol | Type Flagz Frice | Prce2 | Status

[+] DEMOZ5830 By 4 BALIE b arket M one Feady to zend
DEMOZEE20 Sell 15 ESUR Lirnit GTC 1.50 Ready to zend
DEMOZ5330 Buy 4 BEUEG b arket Mone Ready to zend
DEMOZ25830 By 1% EDUEG b arket Maone Ready to zend

£ >
Mew COrder Transmit E-LMT B-MKT S-LMT S-MKT | Submit &l Delete Clear | [ Load B

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP
a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price
The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;

PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.
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Price2

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status
1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry [
Auba Factor Settings

-

Bup Stop Limit (0.00 (4] 0.00 3] Stop 129575 %] Limt 129575 [4]
Sell Limit 000 3 Limit 1295.75 2 Sell Limit
[uantity Symbal
0 | [ESUE v Last 129575
- . Size -

Bid 129550 . Sell Bid
Aubo Factor Settings
Buy Limit 000 2] Limit 1295.75 2
SellStopLimt 0.00 (2] (000 3 Stop129675 2] Limit123575 3

Auto Factor Settings

Buy Stop Limit
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Orders

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

®  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop

Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

(] Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

. Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price
Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size

The number of buyers at the bid price
Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’'t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e  No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

®  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

®  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e |LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e Can only be executed at the limit price or higher.

Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch".
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Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leunch
Symbok | || Leunch | Swmbek | [s]| Leurch
Symbok | %] Lawnch | Spmbok | [s| Launen
Symbok | || Launch | Spmbok | [w] | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wieww | Reports  Setup Toolbox  Help Qpen &

Lock windows

Show Tabs Total PAL
Layout p | 28000 USD
Positions »

Account Summary

Open Orders

Completed Crders

Order Tickets 3

Quokes

Cepth of Market » m Mew, .,

Charts » ESLiG

ommunications GELE
E7UG

e The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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# DOM

-,

Account: |DEM|:|35399

]

Contract: | ESLE

]

| oK

H Cancel ]

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wieww | Reports  Setup Toolbox  Help Qpen &
Lok, Windows
Show Tabs Total PAL
Lavout y | noouso
Positions »
Account Summary
Open Orders
Completed Crders
Order Tickets 3
Quokes
Cepth of Market » | Mew, .,
Charts 3 | Folle
ommunications GELE
E7UG
Quotes

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

guote you have highlighted.

Quotes Test Add Price alert

Symbol

ESUG 1

GA LG

GCLG Do |
FDAXUG chart

6EUG ar

6116 Column 3etup. ..

gf:—;ﬁ Export ko CSY..,
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DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price Alert
Symbol 4
ESLUIG 1 |
GALIG
6CLIG DM |
FDAXUIG h
6EUG Chark
6.6 Colurnn Setup. ..
gi:—;ﬁ Export ko CSY...
View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup  Toolbox  Help Qpen ¢

Lock Windows
Shon Tabs Total PAL

Lavout , 0.00 USD

Pasitions 3
Accounk Surmraty

Cpen Orders

Completed Orders

Order Tickets *

Quokes

Depth of Market 3 | e, ..

Charts » | ESLG

Zommunications CELE
E¥lG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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# ESUG - Depth of Market

DREX]

N e A A=

il

Open
Cha
DEMOS5399 -

1004 Total PAL

[ty

-$3.000.00

|Chart L

20 (2 1305.00 [ Exit at MET ] [ Reverse ]

Pos:

il
1302.00
1302.75
130250
1302.25
1302.00
-
| BwMKT || Gotolast || SelMkT |
Bid
# 6A76 - Depth of Market M=)
= | [F 5 |aF v A G || DEMOggses -
Oty T4 TotalPA $0.00
Pos: a
| CancelBids || Cancelan |
-
T
1 528
Left Click: LIMIT |75 27 I
Right Click: STOP EE.EE e
5 Il
-
| BuwMKT || Gotlast || selmkT |

Right Click: STP
1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2. The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT
1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price
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# 6A76 - Depth of Market =Jo/&d

=W | [F # | &F v (A G |G| DEMO99999 -
Gty 1% Tatal PAL 41000
Pos: 1@7523) | Exit atMKT | [ Reverse |
| CancelBids || Canceldll || CancelOffers |

Left Click: LIMIT
Right Click: STOP

[ Buy MET ] [ o to Last ]

Right Click: STP
1. Rightclick in the red column at the price you would like to places a sell STP

2.  The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT
1. Leftclickin the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected
Modify Price/Quantity of an Order

Price of an Order
1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price

Orders
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FX]

)

# ESZ6 - Depth of Market

| @ & |efF v 34 ||  DEMozssso -
Oty 1% Total PAL $ 662,50
Poz: o

[ Cancel Bids H Cancel Al H Cancel Offers ]

1331.00
1330.75
133050
133025
1330.00
1329.75

........

1329.25
1329.00

B

Left Click: Modify Oty
Right Click: Cancel
Drag: Madify Price

| BuwMKT || Gotolast || selMkT |

Quantity of an Order
1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

"¢ B =
- N I 1= DEMC25830 - -
Ifr_l_ai"'?é_}lrﬂl |
ity 1% Total PAL: $ BE2.50 14
13
Paoz: 0 12
[ Cancel Bids ] [ Cancel &l ] [ Cancel Offers ] ::1['
:

........ E
| E 1 :
I 133325

| Left Click: Modify Gy
1333.00 Ft Click: Modif

e 133275 Right Click: Cancel
I 1332 R0 I Drag: Modify Price
I 13225 1 k
I 133200 G 2
N 1331.75 1
N 133150 EEHE

- EEm -

| BuMKT || Gotolast || selmkT |

Thumbtack
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Stay on Top

Orders

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the

ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

# 6AZ6 - Depth of Market

BEx]

| [F & | Bf ¥ (3 G [l | DEMO999 -
Qty: 1% TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
75.15
75.14
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelmkT |

# 6AZ6 - Depth of Market

BEx]

@ || @ & |F v (35 |Mll |  DEmMosgsss -
Oty 113 TotalPAL: $0.00
Poz 0
| CancelBids || Canceltu |
il
75.15
75.14
75.13
75.12
7511
-
| BwMKT || Gotolast || SelmkT |

Display Options

Auto Center Price

This Options keeps the MKT prices in the center of the viewable length of the DOM

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.

45



OECTraderUserGuide

46

Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-

& DOM Setup
Display | Wumber Pad | Font & Colors

Dizplay Items

[] Ao Center Price [] OpenPAL

[] Open Orders Stats Open Poz Price

Auto Surm BidAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad



Orders

@ DOM Setup x|

Configure the number pad

Setto Zera
1 2 3
4 4] 10
15 0 20 | BO

Set to Defaulk:

[ k. H Cancel ][ Apply

Font & Colors

e  Allows Traders to change the DOM and the colors of the orders

e OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

[ ]

The option to restore the defaults is available if the color scheme does not work for the trader

# DOM Setup X|

Fart

AaBbyyez [ Change font . ]

‘wharking order colars
oco: | I~ |
Stop: | I v |
TraiingStop: | I~ |

[] Save az Defaults [ Load Defaults ]

[ k. H Cancel ][ Apply ]
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Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

# 6AZ6 - Depth of Market

[ setwozen | [E]S 57 ¥ (3 6 )40

Oty T TotalPAL

Pos: 2 @ 7531 @
[ CancelBids | [ Cancelall |

Set to Defaulkz

F

75.34
Bl 2| 7533

OCO Orders

Order Cancel Order (OCO)
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" .| X
= | [ 5 ? 3 S |l | DEMO4704 - |
Qty: 5% TatalPAL: $0.00

Pos 0 @ Confirm orders

a Buw 5 ESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

B -
I
- [ Yes ] [ Ha
.
10 1326.00
1325.75
2720 132550
1325.25
1325.00
I 1324.75
E 132450
Left Click: OO LIMIT
| BuwMkT || Gotolast || selmkr |

1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

3. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

5. Working OCO orders are displayed in blue color by default.

Order Flags
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BX]

L

# ESZ6 - Depth of Market

= | [ 5 - =, |l | DEMOZ5830 -
Qty: 0/ Total P/ $1,000.00
Fos: 1]

<
I 1329.00
13227 R
122850 [
122825 R
122800 [
2615 122775 R

1227 RN
N - BEos

Order Flags

@ Nore O GTC O FOK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

®  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

e  No order can be guaranteed an execution
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# ESZ6 - Depth of Market

mE]

A | 3 & | ef "?IF} |l |  DEMos7094 ~
Oty 5/%]  TatalPAL: $0.00
Fos: 0
Fs
132675
1326.50
1326.25
1326.00
132575
132550
1325.25
1325.00
1324.75
TE30 -
| BuwMkT || Gotolast || selmkr |
[ ] Stop Limit [ ] Trailing Stop
Factor; Factor; 0.25 {3}
Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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ESZ6 - Depth of Market Mi==
W | 3 & |=f v AlE ||l | DEMo47094 -
Oy 5% TotalPAL $0.00
Fos: 0
- [Cffer
[ 1327.75 2327
e 132750 2335
| 132725 [EXED
1327.00
132675
- 10062
| BuwMkT || Gotolast || Selmkr |
[ ] Buy Bracket [] Sell Bracket
[ ] Sell Limit [] Buy Stop
Factor: Factor:
[ ] 5Sell Stop [] By Limit
Factor: Factor:

52

Buy Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side

orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.

Sell Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.



P/L

ESZ6 - Depth of Market

L

=]

=1 | [ & |oF [¥ ] & |l | [oEmossssn -
Oy 003  TotalPL DEMOZ5E30

DEMOB5399
Poz: 1]

- Offer
- 1329.25 lﬂﬂ
1329.00
1117 132875 -
1328.50 Il
| 4 | 132825 I
-

Goto Last

Order Flags
() Mone (O GTC (3 FOE. (O 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
| | [ & |F v A G |l | DEMo47ond -
ity 5l Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1326.50
1325.25

-

| BuwMKT || Gotolast || SelmkT |

Open P/L or Current P/L

Orders
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@ ESZ6 - Depth of Market LEE)
A | 3 & |EF v (A 5 || DEMozssso -
Oty 0% | Total PAL $1,000.00
Pos: 0

-
| 1329.25 1
1329.00
1328.75
3883 1328.50
N 132825
e

3o to Last

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

%]

L)

ESZ6 - Depth of Market

| [F & | Ef ¢ (3 5 Gl | DEMO2S830 -
Oty 5% TotalPAL $ 81250
Fos: 5@ 132350 [ Exit at MET ] [ Reverse ]
| CancelBids || Cancelal |
-
1348 13292 [N
N 1124 122900 [
3661 122875 [
2621 122850 [
3932 122826 [
| 4 | 152800 N
I 13277
1 132750 [
| 2 132725
I 132700 [
I 13675
[ 1 132650 [
1326.25
-
| BuwMKT || Gotlast || selmkT |
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

" ] b
42 | @ 4 [BF| v (3 G @@ | Demozssi0 -]
Qty: 5% TotalPAL: $ 812,50
Pos: 5@ 132375 I Euit at MET l [ Reverze ]
| CancelBids || Cancelal |
I 1330.00
B = 132975 [EEWD
1061 | 132950 (oo S
1329 25 ) Order Confirmation
I 3403 | 1328.00 _
Eo64 137875 Account; DEMOZE820
1328.50 Send SELL 5 ESZ6 MKT?
8 | 1328.25
4 | 1328.00
N 1327.75 | ok | [ Cancsl
1| 1327.50
I 122725 [
1327.00
-
| BuMKT || Gotolast || selMkT |
Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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" : X
=) @ 5 ) ef v (3 G |6l DEMo2sesn -
Qty: 1% Tatal PAL $ 725.00
Pos: 1@132975 | ExitatMKT | | Reverse |

id E S Offer
el 17 |p 132975
2749 1329.50 ~
2105 132975 Eﬂrder Confirmation
3475 1329.00
| 2 | 132850 @ Send SELL 2 ESZB MKT?
8 | 1326.25
4 | 1326.00
I 1327.75 [ ok, ] [ Cancel
1| 1327.50
. 132725
I 132700 [
1326.75
-~
| BuMKT || Gotolast || SelmkT |
Cancel orders
¥ £SZ6 - Depth of Market =)<
=R | [ 5| &F ¢ (2 [[ll|  DEMo2ssio -
Oty 11 Total P $ 587.50
Poz: -1 @ 133025 [ Exit at MET ] [ Beverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Cancel Offers ]
Eid - Offer
I 133328 [
I 133300 [
I 133275 HEE
I 133250 [
I 13322 A
I 133200 A
I 122175 [
| 1331.50 3160
I 1331.25 3327
-
| BuwMKT || Gotolast ||  selmkT |

Cancel Bids
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market
# ESZ6 - Depth of Market M=
A | [ & |EF v (A 45 || DEMo2sss0 -
Oty 1% Total P/ $ B87.50
Fos: -1 @ 1330.25 [ Exit at MET ] [ Reverse ]
[ Cancel Bids ] [ Canicel All ] [ Cancel Offers ]
- Offer
1333.25 ]
1333.00 I
1332.75
1332.50 e
1332.25 e
1332.00 e
1331.75 e
1331.50
1331.25 3327

- 13079

| BuwMKT || Gotolast || SelMKT |

Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

Order Default

Can create default orders for each account which will appear when a new order is being placed after clicking on
NEW ORDER in the AOE.

a. Goto "Orders" > "Order Defaults..."
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b.

Enter your default parameters and hit "OK"

mﬂrder Defaults

Account; DEMOZ5830 V
Drefault Order for

Buy/Sell Buy V

Syrnbaol: ESUE

OrderType: Market ™

Flag: Maone v

(] ] [ Cancel

Contract Setup

Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and
guotes window setup.

Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see
all of the contracts included in that window. Click to add a checkmark next to the contracts you want to see in
your drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

Once you have added the desired contracts to the contract setup “Selected” box you will next want to select
the months that you want to trade. If you change the month’s column to the “Nearest 2” selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the
contracts then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back
in.



Orders

# Contract Setup E]@
Available: Selected:
+ Currencies Description Symbol | Months ||
= Energies Auzszie Dollar B, Mearest
EH - Heating Ol Biritish Pound &R Mearest
CL - Crude 0l [pit] Canadian Daollar BC Mearest
GECL - Crude Ol Eura Fis Currencies EE Mearest
GHO - Heating Dil Japanese Yen gl Mearest
Brazilian Real fL Mearest
GHU - Unleaded Merican Peso =] Mearest
GNG - HH Natural Gas Mew Zealand D ollar BN Mearast
HH - Natural Gas Last-day Russian Fuble ER Mearest
HO - Heating Ol [pit) Swisz Franc g5 Mearest
HF - Matural Gas Gouth African Rand [ Mearest
HU - Unleaded [pit] Ethanal [pit] AC MNearest
NG - HH Natural Gas [pi) iluss!e DD"a.'t [pit iE meam:
6 - HH Natural Gas mitY H;‘;“t::;rgi[lp' ! o e
LH - Heating _Dil !'"iNY Sopbean Oil [pit] BO Mearest
Gk - Crude Ol milly Biitish Pound [pit] BP MNearest
QU - Gasoline mit'y’ Brazilian FReal [pit] BR Mearest
RT - RBOB Gasoline Carn [pit) C Mearest
WS - Crude Oil Cocoa [pit) [ Mearest
" Financials l:anadia_n D_nllar [pit] CD Mearest
5 Grains Crude Oil [pit) CL Mearest
, Catton Mo, 2 [pit] CT Mearest
# [#] Indices Dl [pit) 0 Nearest
+ Meats LS Dallar [k Mearest
+ Metals E-Miri Euro F EV MNearest
+ Softg Evra Fx Currencies [pit] EC Mearest
Euro Dallar [pit] ED Mearest .
<1 Mo, LIBOR nitl EM Mearest )_.v.

e Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and
click “OK”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in Global Zen Trader. This gives the trader an
opportunity to confirm the order before the order is sent for execution. This feature is optional and is turned on by
default.
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OECTrader Demo

File  Account | Orders | Communications Quoktes  Wiew  Reporks Setup Toolbox  f

Abbreviated Order Enkry Chrl+1
Symbol | #EBo Turbo Qrder Enkry Chrl+2 Pos| % Tatal PAL
ECUE Rapid Order Enkry Chrl+3 5 $550.00
ESLE 10 $2.625.00
Depth OF Market Order Entry Chrl+4
COrder Defaules, ..
- ,
Average Postion Clear After Submit
Contrackt Setup...
A CCount | Confirmations 2 | Mew Order
DEMD25830 Natifications v [v] cancel order
Show Cancelled Orders
¥ || Show Rejected Crders |
[ II m [%
Order Confirmation
- Account: DEMO 25530
O Send BUY 5 BAUG MET?

[ Ok, ] [ Cancel

Notifications

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel
Failed".
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Orders

File  Account

Symbol | #HBo

ECLIE
ESLE

Ayerage Position

Account
DEMOZ25830

Qrders | Communications  Quotes  Yiew  Reports  Setup Toolbox  Help 0
abbreviated Order Entry Chrl+1
Turbo Order Entry Chrl+2 Foz| % Total PAL
Fuapid Order Enkry Chrl+3 d $300.00
10 $2.750.00
Depth OF Market Order Enkry Chrl+4
Crder Defaults, .,
Clear After Submit
Conkrack Setup..,.
Confirmations g Surmhinl Price |L_ast Cooc

Matifications

v ] mewr

Show Cancelled Orders
Show Rejected Orders

Maodify or Cancel Failed

m OECTrader Demo

-,

Cloze

\_‘l) & fill 100231 298 25] has been added inta Order #733150

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account

DEMOZ5830
DErMOS5333
DEMOS5339
CERMOZ5830

Order #

F70E34
780529
FE3150
783258

State

Cancelled
Completed
Completed
Rejected

Side
Buy
Buy
Sell
Buy

Gty
0/3
20420
100
000

Symbal Ay Price
ESLE
ESLE 1297 75
ESLE 1298 25
ECUG
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Communications

Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.
Decide if you would rather hear a sound or see an alert box.
To access Sound Alerts:

a. Communications > Sound Alerts

& Alert Settings

Channel Saound Level
Cancel Failed <default: Alert Box
Dezk Meszage <default: Sound
Fill Received <default: Alert Bow
b odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Fillzd <default: Sound
Order |zzued <default: Sound
Order Rejected <default: Alert Box

<default: v @

Level | Alert B v

o] (o]

To configure:

a. Highlight the channel that you want to assign the sound to.

b.  Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files are located:
(C:/WINDOWS/Media)

c. Hit"Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you want sounds
only.

e. Hit"OK"

Message History
See your message history in detail of all previous chat sessions you have had with the brokers.

Click on "View" to view within the software or PDF to export into a PDF file or Excel to export into a .exe file.
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& Message History
File
Begin Date:; End Drate:
08/23/2006 00:00 ||| | 08/23/2006 2359 |+ [ Wiew ] [ PDF ] [ Excel ]
H 4 Page1of1 bk M ]
Chat History for DFormicab7
Time From -> To M
08/23/2006
15:28:33.607 DFormicas?y -= Danield  |Hello T have a question.
15:28:47.170 DFormicas? -= Danield [ What is the current symbaol of th
15:29:13.513 Daniels -= DFormicas? | The current symbaol for the mini =
15:29:23.763 DFormicas? -= Danield | Thank vou !
15:29:35.730 DanielA -= DFormicas? | Your Welcome!
Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hello | have a question. A | | Danield
3:28:50 PM to DamelA\what iz the curent zumbol of the [

mini 5P 500 7

3:29:17 PM DanielA: The current symbaol for the mini S&F

A00 iz ESUR -

D-30-3F Dhd b M amanl A - Tl - | L J

In order to initiate chat with a BROKER, select their name (i.e. OECBroker9) and type your message in the open row
at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT button
and the broker you selected will receive your message. The drop box is there for your reference so you can repeat
your self with previous comments or say the same thing to a different broker by just clicking into the drop box and
selected the previously written text.

To access Chat:

a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
OEC population. It also displays Risk messages such as available credit, etc.
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Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD,Order would need credit of 6012.52
15D [zash available iz 37862.43 15D]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.
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Quotes

Add Market
To add a Market from Quotes window:

Right-click anywhere in the "Quotes" window and select "Add Market"
To add a Market from the main menu:

Main menu, go to "Quotes" > "Add Market"

The Market Selection box will appear. Just select the desired contract and hit "OK".

-,

rm Market Selection
Contract Title: |E.-’1'-.L|E [v]
[ (] ] [ Cancel ]
Notes:

a. Add a market by contract
b.  Pit contracts are snap-shots

c.  Electronic contracts are streaming

Add Market Group
To add a Market from the Quotes window:

Right-click on the Quotes window and select "Add Market Group".
To add a Market from the Main menu:

Go to "Quotes" > "Add Market Group".

The "Market Group Selection" box will appear. Select the market group and the nearest month or all months.

m Market Group Selection
Group Title: b onths:
| Curmencies [VI | MHearest 1 [VI
[ ()4 ] ’ Cancel ]
Remove Market
Remove the highlighted market from the Quotes window.
Quotes
Symbol Add Market Bid...
ESUG add Market Group 11
6A L6 | Remove Market | 109
6CU6 r 124
R |'r=“-‘“—"-”—“—""“"="—|
FDAXUG i Remove Market 14

1. To remove a Market:
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a. Highlight the market in the Quotes window

b.  Right-click within the Quotes window and select "Remove Market"

2. To remove a Market
a. Highlight the market in the Quotes window

b.  Main menu "Quotes" > "Remove Market"

Remove All Markets

Remove all markets from quote window.

Quotes
Symbol La #dd Marlket
ESUG 1305.0 &dd Market Group
6A L6 75.€ Remove Market
6CLIG g0.(
FDﬂXUﬁ 53?4 | Remaove All Markets |
GE L6 128.( ine
& o rdRemove Al Markets

1. To remove all Markets:

a. Right-click anywhere in the Quotes window and select "Remove All Markets"

2. Toremove all Markets:

a. Main menu "Quotes" > "Remove All Markest"

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

1. Toinsert a blank line:

a. Highlight the contract that you want to have the blank line insert just above
b. Right-click and select "Insert Blank Line"

2. Toinsert a blank line:
a. Highlight the contract that you want to have the blank line insert just above

b. Main menu "Quotes" > "Insert Blank Line"

Quotes
Symbol #dd Market id
ESUG &dd Market Group 50
6A L6 Remove Market 89
6CLIG ri
EDAXU6 Remove All Markets ) 5
Insert Blank Line
GELIG
Mg =] |

Move up/Move Down

Move the highlighted contract up/down.

To move a contract up/down:

a. Highlight the contract in the Quotes window
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b. Right-click and select "Move Up" or "Move Down"

Sort by Alpha

Sort all the contracts in the Quotes window in alphabetic order.

To sort by alphabetic order:

Quotes

a. Right-click anywhere in the Quotes window and select "Sort by Alpha"

Custom Price Format

Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.

-,

m Price Format
BSLIE
Default Format Drefault Multiplier
w2 * 000000
wid * 000001
w8 *0.0001
w16 *0.00
wiaz 00
w4 01
w128 “1
/256 10
0 *100
nao *1000
Q.00 *10000
0.oon *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000
Apply ] [ Cancel
Font

Customize the font of your Quotes window.
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= =~
Font
Eant: Fant ztyle: Size:
Microzoft Sans Senf Reqgular a [ (] l
)} Microzoft Sans Senf [~ | | Fegular a e
{} Monotype Corsiva ] [talic | E
() M5 Outloak, Bald 10 3
(} M5 Reference Sans 5| | Bald ltalic 1
{} M5 Reference Specia 12
(} v Boli 14
{} Palating Linotype [V] 16 [V]
Effectz Sample
[] Strikeout
AaBbv
[ ] Underline aBbYyZ2
Script:
|Western [V]
Rename...

Ability to rename the title of the Quotes window.

Go to "Quotes" > "Rename...", enter the title name and hit "OK".

¥ 1

Custom name of Quote...

Pleaze enter new name:

[uotes Test

I ] ] [ Cancel

The renamed Quotes window title would look like the one below.

Quotes Test
Symbol Last| Last\ol Bid| BidSize
ESUG 1297.75 10 1297.50 228
GAUG 76.76 4 76,76 7
GCLIG 90.11 1 90.11 17
GELIG 127.81 3 1481 22
GG 3.674 1 8.673 240
65U/6 309.3 ] 509.1 21

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.
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m OECTrader Demo

Alert Price  1238.00 % (®) <=
0=
) Auto

Alert Test [optional]
ESUE went below or egual to 1298.00

1] l [ Cancel ]

When the price criteria is met, the alert box is displayed.

-,

m OECTrader Demo

1 ESUE went below or equal ta 1233.00
e,

Quotes

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price

Alert".

View Price Alerts...

Go to "Quotes" > "View Price Alerts".

To remove one alert, select one alert and hit "Remove". To remove all alerts, just hit "Remove All".

m Price Alerts

1

barket | Price IJzer Meszage

ESLE <=1298.00 ESUE went below or equal to 1233.00

Edit Femove Fiemove All

Depth or Market (DOM)

Opens the DOM for a specific contract. Jut highlight a contract from the Quotes window then select "DOM".
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Quotes Test Add Price alert

Symbol 4
ESUG 1 |
GA LG

GCLIG Do |
FDAXUG chart

6EUG ar

6.6 Column Setup...

g‘f:;ﬁ Export ko CSY...

Next, the DOM window will open.

'@ ESUG - Depth of Market LoE)

| [ & |&F v (A 5 || DEmMozsszo -
Qty: 0% TatalPAL: $2,125.00
Fos: 10 129200 [ Exit at MET ] [ Reverze ]

F 9
I 1297.50
1297.25
184 | 1297.00
1296.75
1557 129650
v

3o ko Last

Column Setup

Check the columns that you want visible from the Quotes window. Then, hit "Save" to view your the changes.
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m Quotes Test

Symbaol L
Last

Laztval

Bid

BidSize

Iz

AgkSize

High

Loy

Chg

Chaoi
Tatakal
Open

Settle

[] Updated

[] Baze Contract
[ ] Expires

[] Description

[] Cumrency [v]

Cirag a column by mouze or Presz Chl-lp or
Ctrl-Drava ko change the column order

[ Save l [ Cancel

Export to CSV

Quotes

Exports your Quotes window data to an excel file. After selecting this option you will see a confirmation dialog

box.

To export all items just hit "Yes".

To export selected items, you would have to first highlight the desired items from the Quotes window by
pressing CTRL left mouse click each item. Then, select the "Export to CSV..." option and hit "No" in the

confirmation dialog box.

~

Export

-,

Do wou wankt export all ikemsy
fes - all items, Mo - selected item only)

o oves [ Mo ] [ Cancel

)
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View

Lock/Unlock Windows

Wiewy | Reports  Setup Toolbox  Help

W | Lock Windows ”_

| SAEmUELS Total PAL
Layouk p | -B2B0.000USD

To lock Global Zen Trader windows:
a. Main menu, click on "View" > "Lock Windows".

b.  When a check is next to "Lock Windows" then the windows will stay in the current location and are not
configurable.

To unlock Global Zen Trader windows:
a. Main menu, click on "View" > "Lock Windows" and make sure that there isn't a check next to "Lock Windows"

b.  Uncheck "Lock Windows" then the windows will become movable and configurable.

Show Tabs

Some of the windows within Global Zen Trader have tabs available which can be displayed by selecting View >
Show Tabs. The tabs will appear below the box they are associated with

Example 1: Positions window has "Average Positions" and "Detailed Positions"

Symbaol | Awg Buy Price | Awag. Sell Price | Amount | Realized PAL

ECLIE 30.04 0.00 ] 0.0 usD
ESUE 1233.00 0.00 10 0.a0usD

Average Pozitionz | Detailed Positions

Example 2: Order Tickets window has "Standard", "Turbo", 'Rapid”, "DOM".

72



Abbreviated Order Enry
Side hdarket Selection
() Buy Cuartity Symbal
O sel 0 | [BAUE
Order Specs
Type: | Market v Flag: | Hone

| BLMT F3 | | B-MKT F4 |

Mew Order F8 | | S-LMT F5 | | 5-MKT F5 |

Standard | Twbao | Rapid | DOk

Layout

Layout

View

Template: v

Layout offers the ability to save different window configurations and delete existing configurations.

Layout also allows the trader to RESTORE DEFAULT LAYOUT; which is the initial layout that appeared when the

software was first downloaded.

Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

-,

Save Layout

Enter name af layout;

Mullayout]

l OF. ] [ Cancel

Once the layout is saved it will be available under View > Layouts.
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Wiews | Reports  Setup Toolbox  Help Cpen a Live Accounk
Lock Windows |
Show Tabs |
| Layout [ Save..
Positions 3 Delete. ..
Account Summary Restore Default Layout
Cpen Orders MyLavoutl
Completed Orders
Crder Tickets 3
Quates Arccount Order #
1 DEMOBE399 7a0529
Depth of Market r — DEROBR399 F83150
harts , i DEMOZ5830 7a3258
DEMOB5399 Ta3704
Cornrnunic ations » ;
Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".

Configuring Windows

Docked Windows

To configure that specific window, right-click on any of the boxes to view a menu as the one below.

View information on how to unlock a window.

Account Summarny [X]
Close 1
ProfitfLoss Urelots
Epelrj PQLF',-'L Canfigure. .,
ealize
Tatal PAL Shiow Tool Bar
Balance Top Header
Met Lig Left Header |
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).

Undock

The DOCKED form is the form that appears on the default layout. Each box its nicely compacted within
the width and height of the Global Zen Trader platform. Any undocked boxes will appear as free flowing
windows. The UNDOCK feature will remove the selected box from the docked form and display the
selected box as a free flowing window.

If a free flowing undocked box is open, when the Global Zen Trader platform is closed/minimized the free

flowing box will close/minimize with it.




Live Account

View

Accounk: DEMOZ5E30

Account Summary = &
Tl:ltal .........
Profit/Lossz
Open PAL $2.175.00 Exit all
Realized PAL $0.00
Tatal PAL $3.175.00
Balance i
Met Lig $ 4886250
%]
Configure...

See Information.
Show Tool Bar

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Top Header

Display the header on the top of the box running from left to right the entire height of the box.
Left Header

Display the header on the left-side of the box running from top to bottom the entire height of the box.

Undocked Windows

Once the windows are unlocked the ability to change the windows are endless. Perform a mouse right-click on
the header of the undocked window to view a menu like the one shown below.

View information on how to lock/unlock windows.

Account Summary sl
Profit/Loss Move
Open P/L $ 36 Size
Realized F/L i
Tatal PAL %36
O Maximize
Balance |
Met Lig $ 493 ¥ Close Alt+F4
Configure... 1
r Shows Toolbars
v Dockable
Independent
Skay On Top

Move
Allow to move the box without activating the blue docking indicator arrows.
Size

Allow to change the size of the box. Same result is obtained by carefully hovering the mouse on one of
the borders of the box until the mouse cursor changes to a double-pointed arrow, at this point you would
want to left-press your mouse and drag until the desired size is achieved.

Maximize

75



OECTraderUserGuide

76

Maximize the window to the whole size of your screen.
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).
Configure...

See Information.
Show Tool Bars

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Dockable

When 'Dockable' is checked, dragging the undocked window will show the the layout configuration tool
(blue indicator arrows) which allow to dock the window.
Independent

When 'Independent' is checked, the undocked window will change its look to that of a regular window.
Stay on Top

When 'Stay on Top' is checked, the window will remain visible at all times; it will never be under any other
window on your screen.

Docking a Window

1 Live Account Accounk: DEMOZ5E30
Account Summary = &
Tl:ltal .........
ProfitfLoss
Open PAL $2.175.00 Exit all
Fealized P/L $0.00
Tatal P/L $3175.00
Balance I
Met Lig $ 43,862.50
]

Perform a Left-click and leave pressed the header section of the window. Drag the window slowly onto the
box you desire to place it, you should see the layout configuration tool (blue indicator arrows) shown in the
below image.



View

en FAL al PAL |
uouso 1,]L|SD Tatal
i M & ¥ Profit/Loss
i » Qpen F/L % 3.650.00
Realized PAL $0.00
Toatal AL £ 2.650.00
Balance
g Met Lig $49,337.50
d Account | Or

Keep pressing the header of you window, place your cursor over the location in relation to the box that is
highlighted. In this case we select the single right options in the layout configuration tool to dock the
Account Summary window in its original spot. Or, If you want it to stretch across the bottom place your
cursor on the bottom option of the layout configuration tool.

Configure

To configure a window, first make sure that the trader windows are unlocked. View information on how to
unlock a window.

Account Summary el
Profit/Loss Maovve
Open P/L $ 3R Size
Realized F/L i
Tatal PAL $36
O Maximize
Balance
Met Lig $ 492 X Close alt+F4
Corfigure. .. 1
r Show Toolbars
v Dockable
Independent
Skay On Top

Then, place the mouse on the header of the window, perform a right click and select ‘Configure...".

CONFIGURE allows traders to open the specific options for the selected box. Whether it be toolbar
options, menu options or general box settings.
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Account Summary =

Toolbars = Menu = Setkings -

Default

All Currencies
Setup
Special

Separatar

Toolbar
Gives the options to have one or multiple toolbars with various tools within each toolbar. At any time
a trade can restore the toolbar to the default layout.

Menu

Offers options to add different utilities into the menu option for each box.
Settings

Provides the ability to change the types of methods traders wish to use the toobar.

Positions

Average positions
Displays the average positions open on each specific contract that has been traded.
In order to go flat in a specific contract:

a. Inorderto go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately
transmit a market order for the contract selected to flatten the position.

b. In order to go flat all current contracts with open positions left click the Exit All. This function will immediately
transmit a market order to exit all contracts with open positions.

Symbal | HBought | Avwg Buy Price | #S5old | Awg Sell Price | Met Pog F Total F/L

BCUG 0 0.00 5 30.03 ] -$60.00 | Exit Al
ESUE 20 1233.75 0 0.00 20 $250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.
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4| ¥
Symbal | Awg. Buy Price | Awg. Sell Price | Amount Realized F/L Open P/L Total F/L
BCLE 0,00 a0.03 -5 0,00 USD 10,00 0sD 000 LS | Exit Al
ESUE 1293.75 Q.00 20 0.00 LS 280,00 USD 28000050

Account Summary

You can customize the "Account Summary" window by hiding the rows that you do not want to see.

Account Summarny (3]
Total
Profit/Loss
Open PAL $0.00
Realized PAL $13.875.00
Tatal PAL $13.875.00
Balance
Cazh $ B4 765.00
Open PAL .00
Met Lig $ 64,765.00
Rate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summary ||
Tatal
Profit/Loss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $13.875.00
Balance
Caszh $ 64 765.00
Open PAL .00
Met Lig $ 64,765.00
Rate

all Currencies

| Column Setup, .,

Fork...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.
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.
m Account Summary

BX]

Colurmn Yizibility
Open PAL Hidden w
Realized P/L ==
Total P/L Esl’dma'
Cash Hidden
Open PAL Tarmal
Met Lig Marmal
Fate Marmal
()4 l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.

Total P/L shows the total P/L for both the Open and Realized P/L.

Account Summan

Total 5D
ProfitfLoss

Open F/L $0.00 0.00
Realized P/L -4 95.00 -595.00
Tatal FAL -5 95.00 -595.00

» | all Currencies
A0,167.50
Calurin SetL]E 0.0o

urrencies
Expark bo C34 | 501 E?.51EI
= Font... .

CHF

0.00
0.00
0.00

009
0.00
003

FE73

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Open Orders

Open Orders

Account Ord... State

DEMOBS333 318432 “Waorking
DEMOB5333 818508 ‘Working

Awg. Side | Oty Suymbal
Buy 040 ESUE
Sell 0/2 Wl

Price Last.Crnd
LT 1303.75  #H426574 Cancel all
LMT 4.0000 by DemoBroker #426581

% Find

Open Orders allows traders to view their open orders in addition to the order statisitics. At any time a trade can
cancel the order by clicking “ Cancel” which will cancel the selected order or “Cencel All” which will cancel all the

orders in the Open order box.

Completed Orders



View

Aooount Order #| State Side [ty | Symbal Ay Price
DEMOER339 a18481 Completed By 10410 ESUB 1307.00
DEMOEE339 2818530 Completed Buy 20420 BELE 12849
DEMOBR399 2818533 Completed Sell 5/5 BELB 12850

Completed Orders provides traders with an accurate view of their completed trades from the current session. The
completed orders is color coordinated for easy viewing and customization. Traders can customize anything from the
column setup to the font size by right clicking in the completed orders box area

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

A

Side hdarket Selection
(&) Buy Quiartity Symbuol

0 ESLEG
Order Specs
Type: | Market L") Flag: | Hone L%

| BLMTF2 | | BMKT F4 | Template: v

| New OrderFa | | 5-LMT FS | [ S-#KT FE |

Side
Buy
Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is

called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery
date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol
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Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type

Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
Limit (LMT)

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has
been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:
1. They are activated when the price reaches the order level
2. They become MKT orders once they are activated
MIT orders are used differently from STPs.
Buy MIT below the MKT price to establish a long position.
Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.



View

Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique
allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag
Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (IOC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a. i.e, BUYthe ES at5 QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

b. Traders can have as many Templates as desired for quick an easy trading made for the trader.
You can have different template for the same contract.

d. DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a. Inorderto EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

b. Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently
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c. Allows you to load and save orders from excel.

Turbo Order Entry 4|k
Account Side [ty | Symbal | Type Flags Price | Price2 | Statuz

[+ DEMOZ25830 By 4 BaAllG b arket Mone Fieady to zend
DEMOZEEE0 Sell 15 ESUR Lirnit GTC 1.50 Ready to zend
DEMO25530 By 4 EBEUEG b arket Mone Feady to zend
DEMOZ5530 By 15 EDUG b arket M one Feady to zend

£ >
Mew Order Transmit E-LMT B-MKT S-LMT S-MKT | Submit Al Delste Clear |2 Load 5

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP
a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price

The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;
PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.



Price2

View

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status

1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry
Auba Factor Settings

Bup Stop Limit (0.00 (4] 0.00 3] Stop 1295.75

Sell Limit 000 3 Limit | 1295.75

bAarket Selection Ask 1795 75

[uantity Symbal

0 «| [ESUE v Last 1295 75
Bid 129550

Aubo Factor Settings

Buplimt 000 2] Limit 1235.75

Sell Stop Limit | 0.00 = 0.00 % Stop 123375 5 Limit 1235.75

.v.

.A.
£

.A.
b

e
-

2] Sell Limit
Size
222

.
poalll  Sell Bid

Auto Factor Settings

Buy Stop Limit

85



OECTraderUserGuide

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

®  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop

Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

(] Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

. Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price
Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size

The number of buyers at the bid price
Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’'t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e  No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

®  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

®  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e |LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e Can only be executed at the limit price or higher.

Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch".

87



OECTraderUserGuide

Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leunch
Symbok | || Leunch | Swmbek | [s]| Leurch
Symbok | %] Lawnch | Spmbok | [s| Launen
Symbok | || Launch | Spmbok | [w] | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wieww | Reports  Setup Toolbox  Help Qpen &

Lock windows

Show Tabs Total PAL
Layout p | 28000 USD
Positions »

Account Summary

Open Orders

Completed Crders

Order Tickets 3

Quokes

Cepth of Market » m Mew, .,

Charts » ESLiG

ommunications GELE
E7UG

e The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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rm DOM W
Account; | DEMOBE399 M
Contract: | ESLIE kl

[ ]9 H Cancel ]

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wieww | Reports  Setup Toolbox  Help Qpen &
Lok, Windows
Show Tabs Total PAL
Lavaut Y 0.00 LSO
Positions »
Account Summary
Open Orders
Completed Crders
Order Tickets 3
Quokes
Cepth of Market » | Mew, .,
Charts 3 | Folle
ommunications GELE
E7UG
Quotes

View

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

guote you have highlighted.

Quotes Test Add Price alert

Symbol

ESUG 1

GA LG

GCLG Do |
FDAXUG chart

6EUG ar

6116 Column 3etup. ..

gf:—;ﬁ Export ko CSY..,
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DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price Alert
Symbol 4
ESLUIG 1 |
GALIG
6CLIG DM |
FDAXUIG h
6EUG Chark
6.6 Colurnn Setup. ..
gi:—;ﬁ Export ko CSY...
View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup  Toolbox  Help Qpen ¢

Lock Windows
Shon Tabs Total PAL

Lavout , 0.00 USD

Pasitions 3
Accounk Surmraty

Cpen Orders

Completed Orders

Order Tickets *

Quokes

Depth of Market 3 | e, ..

Charts » | ESLG

Zommunications CELE
E¥lG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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@ ESUG - Depth of Market (22~ ) OB

Open
ICha
S w (3G ||llf  oemossass -

M m
Ot | 1013 TotalPAL: G} ¥ 300000
Pos: 20 @ 1305.00 [ Exit at MET ] [ Reverse ]

il
1302.00
1302.75
1302.50
1302.25
1302.00
-
| BwMKT || Gotolast || SelMkT |
Bid
# 6A76 - Depth of Market M=)
=R | [ 5 |BfF v 3G [l DEMO99sIs -
Oty T4 TotalPA $0.00
Pos: 0
| CancelBids || Cancelan |
-
T
1 w28
Left Click: LIMIT |75 27 I
Right Click: STOP EE.EE e
w5 Il
-
| BuwMKT || Gotlast || selmkT |

Right Click: STP

1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2. The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT

1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price

View
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Offer X
# 6A76 - Depth of Market =Jo/&d

=W | [F # | &F v (A G |G| DEMO99999 -
Gty 1% Tatal PAL 41000
Pos: 1@7523) | Exit atMKT | [ Reverse |
| CancelBids || Canceldll || CancelOffers |

Left Click: LIMIT
Right Click: STOP

[ Buy MET ] [ o to Last ]

Right Click: STP
1. Rightclick in the red column at the price you would like to places a sell STP

2.  The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT

1. Leftclickin the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected
Modify Price/Quantity of an Order

Price of an Order
1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price

92



# ESZ6 - Depth of Market

FX]

)

| @ & |efF v 34 ||  DEMozssso -
Oty 1% Total PAL $ 662,50
Poz: o

[ Cancel Bids H Cancel Al H Cancel Offers ]

Bid

Right Click: Cancel
Drag: Madify Price

........

Left Click: Modify Oty

F Y

1331.00
1330.75
1330.50
1330.25

1330.00

1328.75

1329.25
1329.00

B

| BuwMET ||

3o to Last

|| seimkr |

Quantity of an Order

1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

"¢ B =
- N I 1= DEMC25830 - -
Ifr_l_ai"'?é_}lrﬂl |
ity 1% Total PAL: $ BE2.50 14
13
Paoz: 0 12
[ Cancel Bids ] [ Cancel &l ] [ Cancel Offers ] ::1['
:

........ E
| E 1 :
I 133325

| Left Click: Modify Gy
1333.00 Ft Click: Modif

e 133275 Right Click: Cancel
I 1332 R0 I Drag: Modify Price
I 13225 1 k
I 133200 G 2
N 1331.75 1
N 133150 EEHE

- EEm -

| BuMKT || Gotolast || selmkT |

Thumbtack

View
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Stay on Top

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the
ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

BEx]

# 6AZ6 - Depth of Market

| [F & | Bf ¥ (3 G [l | DEMO999 -
Qty: 1% TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
75.15
75.14
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelmkT |

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.

BEx]

# 6AZ6 - Depth of Market

@ || @ & |F v (35 |Mll |  DEmMosgsss -
Oty 113 TotalPAL: $0.00
Poz 0
| CancelBids || Canceltu |
il
75.15
75.14
75.13
75.12
7511
-
| BwMKT || Gotolast || SelmkT |

Display Options

Auto Center Price
This Options keeps the MKT prices in the center of the viewable length of the DOM
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Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-

& DOM Setup
Display | Wumber Pad | Font & Colors

Dizplay Items

[] Ao Center Price [] OpenPAL

[] Open Orders Stats Open Poz Price

Auto Surm BidAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad
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@ DOM Setup x|

Configure the number pad

Setto Zera
1 2 3
4 4] 10
15 0 20 | BO

Set to Defaulk:

[ k. H Cancel ][ Apply

Font & Colors

e  Allows Traders to change the DOM and the colors of the orders

e OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

[ ]

The option to restore the defaults is available if the color scheme does not work for the trader

# DOM Setup X|

Fart

AaBbyyez [ Change font . ]

‘wharking order colars
oco: | I~ |
Stop: | I v |
TraiingStop: | I~ |

[] Save az Defaults [ Load Defaults ]

[ k. H Cancel ][ Apply ]




View

Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

# 6AZ6 - Depth of Market

[ setwozen | [E]S 57 ¥ (3 6 )40

Oty T TotalPAL

Pos: 2 @ 7531 @
[ CancelBids | [ Cancelall |

Set to Defaulkz

F

75.34
Bl 2| 7533

OCO Orders

Order Cancel Order (OCO)
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" .| X
= | [ 5 ? 3 S |l | DEMO4704 - |
Qty: 5% TatalPAL: $0.00

Pos 0 @ Confirm orders

a Buw 5 ESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

B -
I
- [ Yes ] [ Ha
.
10 1326.00
1325.75
2720 132550
1325.25
1325.00
I 1324.75
E 132450
Left Click: OO LIMIT
| BuwMkT || Gotolast || selmkr |

1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

3. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

5. Working OCO orders are displayed in blue color by default.

Order Flags
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# ESZ6 - Depth of Market

L

BX]

=4 | [ &
by 0 {:}
Fos:

DEMOESE30 -

dlella & i

Toatal FAL:
1]

$1.000.00

Bi

2
(=]
—
&n

f=h
P | | e
== ES
g8 F3| 63|
==&
E

-
==]
¥=1

F

1329.00
1328. 75
1328.50
1328.25
1328.00

1327.75
1927 AN
-

o to Last

Offer

Order Flags
) Mone

O GIC O FoK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

View

®  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be

filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not

be filled unless the price remains at or rises above the limit level

e  No order can be guaranteed an execution
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# ESZ6 - Depth of Market

mE]

A | 3 & | ef "?IF} |l |  DEMos7094 ~
Oty 5/%]  TatalPAL: $0.00
Fos: 0
Fs
132675
1326.50
1326.25
1326.00
132575
132550
1325.25
1325.00
1324.75
TE30 -
| BuwMkT || Gotolast || selmkr |
[ ] Stop Limit [ ] Trailing Stop
Factor; Factor; 0.25 {3}
Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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BE]

W | 3 & |=f v AlE ||l | DEMo47094 -
Oy 5% TotalPAL $0.00
Fos: 0
- [Cffer
[ 1327 75 2327
e 1327 50 2335
I 132725  [REXED
1327.00
132675 [
- 10062
| BuwMkT || Gotolast || Selmkr |
[ ] Buy Bracket [] Sell Bracket
[ ] Sell Limit [] Buy Stop
Factor: Factor:
[ ] 5Sell Stop [] By Limit
Factor: Factor:

Buy Bracket

View

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side

orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.

Sell Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.
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ESZ6 - Depth of Market

=]

L

=1 | [ & |oF [¥ ] & |l | [oEmossssn -
Oy 003  TotalPL DEMOZ5E30

DEMOB5399
Poz: 1]

- Offer
- 1329.25 lﬂﬂ
1329.00
1117 132875 -
1328.50 Il
| 4 | 132825 I
-

Goto Last

Order Flags
() Mone (O GTC (3 FOE. (O 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
| | [ & |F v A G |l | DEMo47ond -
ity 5l Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1326.50
1325.25

-

| BuwMKT || Gotolast || SelmkT |

P/L

Open P/L or Current P/L
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# ESZ6 - Depth of Market

BEx]

A | 3 & |EF v (A 5 || DEMozssso -
Oty 0/ | Tatal P/ $1,000.00
Pos: 0

il
I 1329.25
1329.00
1326.75
132650
o] 122825
e

3o to Last

1

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

ESZ6 - Depth of Market

L)

%]

| [F & | Ef ¢ (3 5 Gl | DEMO2S830 -
Oty 5% TotalPAL $ 81250
Fos: 5@ 132350 [ Exit at MET ] [ Reverse ]
| CancelBids || Cancelal |
-
1348 13292 [N
N 1124 122900 [
3661 122875 [
2621 122850 [
3932 122826 [
| 4 | 152800 N
I 13277
1 132750 [
| 2 132725
I 132700 [
I 13675
[ 1 132650 [
1326.25
-
| BuwMKT || Gotlast || selmkT |

View
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

" ] b
42 | @ 4 [BF| v (3 G @@ | Demozssi0 -]
Qty: 5% TotalPAL: $ 812,50
Pos: 5@ 132375 I Euit at MET l [ Reverze ]
| CancelBids || Cancelal |
I 1330.00
B = 132975 [EEWD
1061 | 132950 (oo S
1329 25 ) Order Confirmation
I 3403 | 1328.00 _
Eo64 137875 Account; DEMOZE820
1328.50 Send SELL 5 ESZ6 MKT?
8 | 1328.25
4 | 1328.00
N 1327.75 | ok | [ Cancsl
1| 1327.50
I 122725 [
1327.00
-
| BuMKT || Gotolast || selMkT |
Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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" : X
= | [F & |EF v (A 4G || DEMozsss0 -
Qty: 1% Tatal PAL $ 725.00
Pos: 1@132975 | ExitatMKT | | Reverse |

id E S Offer
IYCl 17 |p 132975
2749 132950 =
2105 132975 Eﬂrder Confirmation
3475 1329.00
| 2 132850 @ Send SELL 2 ESZE MKT?
8 | 1329 25
4 | 1322.00
- 1327.75 [ k. ] [ Cancel
1 | 1327.50
I 132725 N
I 132700 [
1326.75
-~
| BuMKT || Gotolast || SelmkT |
Cancel orders
# ESZ6 - Depth of Market =)<
= | [ 5 |af ¢ (A5 || DEMo2ss30 -
Oty 11 Total P $ 587.50
Poz: -1 @ 133025 [ Exit at MET ] [ Beverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Cancel Offers ]
Bid - Offer
I 133328 [
I 133300 [
I 133275 HEE
I 133250 [
I 13322 A
I 133200 A
N 122175
I 1331.50 3160
[ 1331.25 3327
-
| BuwMKT || Gotolast ||  selmkT |
Cancel Bids

View
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market
# ESZ6 - Depth of Market M=
A | [ & |EF v (A 45 || DEMo2sss0 -
Oty 1% Total P/ $ B87.50
Pos: -1 @ 133025 [ Exit at MET ] [ Reverse ]
[ Cancel Bids ] [ Cancel &ll ] [ Cancel Offers ]
- Offer
1223225 R
172200
1332.75
133250
122222 R
1zzo0 [N
12175 N
1331.50
1331.25 3327
- 13079
| BuwMKT || Gotolast || SelMKT |
Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

View Quotes
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=ymbol
MG
BB
WG
Sls
ELE
LI
HOUG
5006
FDAXLIG
ERZLG
Ry
CLE

Last
107 04.0
110 11
3.9700
12,4490
54175
1682.25
1.9530
B10.5
58725
7218
7010
2.2875

Last ol

—_

OO MR EOCO —=0Wwom

Bid

107 04.0
11010
0.0000
0.000
0.0000
1582.25
1.9450
a.a
a5720
217
0.00
0.0000

BidSize
1542
2111

a

~ oo =00

o=

Ask
107 04.5
110 11
3.8800
12.410
£.4050
158275
1.9500
0.0
8725
7219
0.00
0.0000

AskSize
2033
708

View

The columns can be configured to be displayed or hidden. Below is a list with all the columns available from the

Quotes window.

Symbol

The contract symbol.

Last

Last price at which the contract was traded.

LastVol

The last amount of Volume that trade that specific contract.

Bid

The bid market price.

BidSize

The total amount of bids on that contract.

Ask

The offer market price.

AskSize

The total amount of offers on that contract.

High

The highest price traded of the contract during this trading session.

Low

The lowest price traded of that highlighted contract during the most current trading session.

Chg

The total amount of change from the opening of the current trading session.

Chg%
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108

The total percentage of change from prev. day settlement.

TotalVol

The total volume traded on that specific contract through the current trading session.

Open

What the price was of the contract at the opening of the current session.

Settle

What the contract price was at the end of the most recent close.

Updated

The most recent time at which the contract's price, bid/ask, volume etc was updated.

Base Contract
The symbol of the contract that is being traded without the year or month attached. e.g: The ESU6'’s base

contract is ES.
Expires

The date the contract will no longer be available to be traded.

Description
The name of the contract. e.g: 2. The ES has a description of E-Mini S&P.

Currency
The currency that the contract is traded in. e.g: 2. ES E-Mini S&P trades in USD and DAX DAX trades in EUR.

Exchange

The exchange that the selected contract is traded on.

Group

The group that the selected contracts falls under e.g. ES is a contract under the Indices Group .

Type
Whether the contract is traded electronically (E) or pit (P).

Start Time

What time the contract opens in relation to the exchange’s time zone. E.g. CME is Chicago Mercantile
Exchange which is located in Chicago, IL on Central Standard Time (CST).

Stop Time

The time the contract closes in relation to the exchange’s time zone.

Tick Size

What the increment amount is per tick. The ES has a Tick Size of .25. e.g. ES has gone from 1309.50 to 1310
therefore it has increased by 2 ticks .

Per Point



View

The total amount of amount effected per point. The ES has a Per Point value of 50. This mean that if the
market moved up one point from 1309 to 1310 someone who was Long would make $50 on a 1 lot. To find out
the per tick value, multiple the Per Point value by the Tick Size. 50 x .25 = 12.50 per tick for the ES.

Charts

Charts - Open
a. Left-click on VIEW in the Toolbar Scroll down to CHARTS one up from the bottom

1. Click on NEW and Market Selection will prompt you

e  Enter the Market you want and click ok

2. Click on anything below the line i.e. Chart — 15 min (ESU6)

e  Thisis a chart that you have either opened during this current session or a chart that you have
save

b. Right Click on the contract you want in the QUOTES box

a. Scroll down to CHARTS one up from the bottom and the chart will appear
c. Launch a DOM

1. In the top toolbar below the title bar will be a set of icons

2. The eight icon from the left looks like a bar chart

3. Put you mouse on it, so it is highlighted and left-click

4. The chart will appear for that DOM
Add Indicator

Add Indicator
Customize or select from a variety of indicators and profiles.
1. Click on ADD INDICATORS in the top left corner of the chart

2. Add indicators via RIGHT_CLICK shortcut. Right-Click any where on the graph and have a menu bow pop up
and select ADD INDICATORS.
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'@ Chart - 15 min (ESU6) m=<|

Contrack,.. |&dd Indicatar = 15 min = OHLC

L vigh 12 Channels 3 r
pY Sl Data r F1304.75
BN Moving Averages k
F1302.00
_s Oseilliakar | e
| Prices k
ABE IH#i Trend Followers » T 795 50
{—i;, & 2008 Yolatility 3
P oime: ,
onnecke g LEE o
g @ C ted | D&f24/2006 16:30 10:44:01 AM .

Volatility
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View

-
# Chart - 15 min (ESU6)
Contract.,, | &dd Indicatar =| 15 min
L, High 12 Channels
b Open 13 Data
B Moving Averages
_s Dscilliator
| F"‘ Prices
pu Huri Trend Followers
Ff’ @ m| Wolakility » Awverage True Range
1 % Yaolumes k Standard Deviation
ip) @ Connected | 08/20/2006 17:15 wolatility
wolatility Chaikins
Wolatility Fatio

Average True Range (ATR)
e  Appears below Contract chart

e  Measures commitment comparing the range between High, Low and Close prices

Standard Deviation (StdDev)
e  Appears below Contract chart

e  Difference between values (Closing Price) and average.

Volatility (Volatility)

®  Appears below Contract chart

Volatility Chaikins (CHV)
®  Appears below Contract chart

e  Difference between high and low prices, indicates the top and bottom of the market

Volatility Ratio (VR)

®  Appears below Contract chart

Channels
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'@ Chart - 15 min (ESU6) m=<|

Contract... | Add Indicator = | 15 min * OHLEC v A
L, High 1E| Channels b Eolinger Band
| Dpen 13 Data » Commaodity Channel Index
b Moving Averages 3 Envelopes
i Oscilliator * Keltner Channel
| Prices 3
i ;‘II Trend Followers 3
Fr"l & 2006 Wolatility 3
4 % Yolumes 3

_.! ) Connected | 0820/2006 17:15 10:54:05 AM

Bollinger Band
e  Will put a Bollinger Band on the chart directly

e  This indicator can be used to measure the relative highness or lowness of price

Commodity Channel Index
e  Will put a Chart below the existing Contract chart

e  Compares Prices with its moving average

Envelope
e Wil apply a envelop directly on the contract chart

e  Plots above and below the moving average at a specified percentage

Keltner Channel
e  Will apply 3 lines to the Contract chart

e  This indicator shows a central moving average line plus channel lines at a distance above and below

Data
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# Chart - 15 min (ESU6)

BEx]

L

b
W

Wi

= 2008

=

Oecilliakor
Prices

Trend Followers
Wolakility

Yolumes

Conkrack,.. |&dd Indicator = 15 min * OHLC o
High 12 | Channels 2 . |‘
Dpen 12! Data ’ | Yolume 75
Moving Averages k

) 2} Connected | 03/20/2006 17:15

10:57:42 AM .

Volume

Moving Averages

Will put a volume chart below the contract chart

Shows the amount of trades at a specific time of the day

# Chart - 15 min (ESU6)

BE]

Conkract...

L, |

b
W

iy

= 2008

e

Exponential M.A. (EMA)

Will apply a line direct to Contract Chart

&dd Indicator = | 15 min = OHLC +
Channels 3 r
Data * F 130475

| Moving Averages 2 Exponential Moving &verage
Oecilliakor J Least Square Moving Average
Prices L Rolling Mowing Average
Trend Followers ] Simple Maving &verage
Wolakility k Triangular Mowing Average
Yalumes » Triple Moving Average

uip @ Connected | 08/20/2006 17:15 Variable Moving Average
Weighted Maoving Average

View

EMA is an average of data calculated over a period of time where the most recent days have more weight

Least Square M.A. (LSMA)

Will apply a line direct to the Contract chart

Rolling M.A. (RMA)

Will apply line direct to Contract chart
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Simple M.A. (SMA)
e Will apply line direct to Contract chart

®  The average of data calculated over a period of time

Triangular M.A. (TMA)
(] Direct line onto Contract chart

®  Average calculated over a period of time where the middle portion of the data has more weight

Triple M.A.

e Applies 3 lines on Contract chart, the Slow, the Fast and the Median

Variable M.A.

e Will apply line direct to Contract chart

Weighted M.A.
(] Direct onto the Contract chart

® An Average where the greater weights are attached to the most recent data, it is calculated from the sum

of the day
Oscillator
— 1
# Chart - 15 min (ESU6) M=%
Contract,.. | Add Indicator = | 15 min * OHLC ~
Lx High 12 Channels 3 r
[ Zeen 13 Diats v L1:304.75
B Moving Averages k
_is | Orscilliabor » Average Directional Index
| Prices » Detrended Price Oscillakor
. ':'Ii Trend Followers 3 Mormenkum
{—ip & 206 Wolatility » Performance
+ % Yolumes k Price Osciliator
) @ Cormected | 08/20/2006 17:15 Rate OF Change
Relative Strength Inde:x
Stochastic
Williarn's %R

Average Directional Index
e  Will appear below the Contract chart

e  Will have three lines, ADX, -DI, +DI

Detrended Price Oscillator

e  Will appear below Contract chart
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View

e  The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any
other price with it's moving average

Momentum

. Will appear below the Contract chart

Performance
e  Will appear under the Contract chart

e  Compares the current Close (or any other price) with the first Close value. Shows how much the Close
price was changed from the beginning

Price Oscillator
e  Will display below Contract chart
e  Rate of Change

®  Appears below Contract chart

Relative Strength Index
®  Appears below Contract chart

e  Compares upward movement of the Close price with the downward movement resulting in a value which
ranges from 0 and 100

Stochastic (%K, %D)
®  Appears below Contract chart

e Indicator helps to find trend reversal searching for a period when close prices is close to low price in up
trending market or close prices is close to high price in down trending market

William’s %R (%R)
®  Places the charting below the Contract chart

e  This indicator is used to measure overbought and oversold levels

Prices
e -,
#! Chart - 15 min (ESU6) M=l
Conkract... |&dd Indicator - | 15 min |*| CHLC =
L, High 12 Channels 3
-4 Open 12 Daka »
W Moving Averages k
5 Dscilliator 3
| | Prices k | Median Price
. Trend Followers 3 Typical Price
Fr" @ 206 Wolakility » weighted Close
" % Waolumes 3 —
_ﬂ i@ Connected 0520/2006 17:15 11:15:30 AM
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Median Price (Median)

®  Places a line directly on the Contract chart

e  Mid-point value of daily prices

Typical Price (Typical)
e  Appears directly on the Contract chart

®  The average value of the daily prices

Weighted Close (Weighted)

®  Appears direct to the Contract chart

[ ]
important price

Trend Followers

Average value of daily prices, only difference is that the closing price has extra weight as the most

# Chart - 15 min (ESU6)

Conkract,.. | Add Indicator - | 15 nirs

L\ High 12 hannels

4 Open 13 Data

S Moving Averages

i Oscilliakor

Prices

Alnc Hﬂhi Trend Followers 3 | MECD
Fﬁ' & 2006 Walakility k Mass Index

1 Iii% Yalumes r Tangent of Linear Regression

," Connected | 032002006 17:15

TRIX

—

MACD (MACD, Histogram, Signal)
®  Appears below Contract chart

e  Compares two moving averages of prices.

Mass Index (MI)
e  Below the Contract chart

Is used with its 9 day Exponential Moving average as signal

Developed to predict trend reversal by comparing difference and range between high and low prices

Tangent of Linear Regression (Tangent)

®  Appears below Contract chart

TRIX (TRIX)

e  Below Contract chart

Volumes
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'@ Chart - 15 min (ESU6) M=)

Contrack,., |&dd Indicatar = 15 min * CHLC -

L\ High 12 Channels 3

'

Open 13
SO Data v L 1204.75
b Moving Averages k
- F 1302 .00
C=cilliator 3

| Prices »
. ,ﬂr\" Trend Followers 3
Fﬁ’ @ 2008 Wolatilitsy 3 m
1 Iiit_a‘ﬁl Yalumes r Accumulation Distribution

| ™ {3 Connected | 05/20/2006 17:15 Ease of Mowvement
Money Flow Index

Megative Yolume Index
On Balance Yolume
Positive Yolurne Inde:x
Price Volurne Trend

Wolume Cscillator

Accumulation/Distribution (A/D)
e  Appears below Contract chart

e  Estimates the strength of price movement with the relationship between volume and prices

Ease of Movement (EoM)
®  Appears below Contract chart

®  Uses volume to estimate how strong the price trend is

Money Flow Index (MFI)
®  Appears below Contract chart

e  Compares upward changes and downward changes of the volume weighted typical prices

Negative Volume Index (NVI)
®  Appears below Contract chart
e  Should be used with PVI

e  Changes only if the volume decreases from the previous day

On Balance Volume (OBV)
e  Appears below Contract chart
®  Measures positive and negative volume flows.

e  Volume is added if the closing price moves up and subtracted if the closing price moves down

Positive Volume Index (PVI)

View
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®  Appears below Contract chart
e  Should be used with NVI

e  Changes only if the volume decreases from the previous day

Price Volume Trend (PVT)
®  Appears below Contract chart
e  Cumulative volume total

e  Calculated by using the relative changes of the Close price

Volume Oscillator (VO)
®  Appears below Contract chart

e  Tries to identify any trends in volume, comparing two moving averages; one with a short period and the
second with a longer period

Period

This function allows you to set the time period for each unit (e.g. bar, candlestick, etc.) of your chart. The minimum
time increment is 1 minute, and the platform can be configured to display periods of length up to one day.

o 1
# Chart - 1 min (ESU6) M=%
Contract,,., Add Indicator = |1 min =| OHLC -

L\ - 1 min ~
High 130550  Laws 1303. = Iiin f—
k- Open 130323 Close 130%.153 min
M 4 mir
LS L1302 75
- F1302.50
| F1301.25
ARC
F F1300.00
1
*| @ 2006 Dpen E Ciw, LLC ﬁi'm
t : :
i €} Connected | 08)28/2006 04:29 11:33:10 aM
Profile
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L

b
W

View

-
# Chart - 3 min (ESU6) =Jo&3
Contract...  Add Indicator = 3 min * OHLC -
High 1304.00  Lowe 130400
Open 1304.00 Close 1304.00 i
Properties
X 1302 .50
Add Indicator 130,75
Period F1293.00
Profile & save Profile...
Area Save As Defaudlt, .,
Series Delete Profile. ..
Drawing Tools Select Profile b A
Expatt Bollinger Band
Auka Scral Wolumes
OfFset Mamentum
b | ZoomIn Chrl+1 Drefault
= Zoom Cut Chr 40 areen On Black

Save Profile

This allows you to save the currently selected chart with all of its settings for future use. Upon selection, this

feature presents you with the opportunity to use a default chart name or create your own chart title for increased

customization and personalization.

Save as Default

This allows you to not only save the currently selected chart but also to set it to your default chart upon the

launching of the platform. This function is recommended for what each trader would consider being the chart
from which he/she obtains the most utility.

Delete Profile

This allows you to remove a previously saved profile.

Select Profile

ADX (Average Directional Index)

This indicator evaluates the strength of the current market trend. The resulting figure is one that indicates
relative strength, with further implication upon the trading style that will prove most effective in a given
market. The oscillator fluctuates from 0 to 100; readings above 40 indicate a strong trend, while readings
below 20 indicate one of relative weakness.

Bollinger Band

These are indicators placed at standard deviation levels away from a simple moving average. The
resultant standard deviation derived from the applied formula indicates the relative volatility of the market.
Volumes

This indicator simply displays different levels of volume in a given market. A volume oscillator is intended
to compare moving averages of varying time periods to compare volumes.
Momentum

The momentum profile provides the trader with a simple moving average on the chart, and, in addition,
charts indicating the momentum and RSI of the market at its current state.
Default

119



OECTraderUserGuide

120

Are

This function returns the trader to the chart profile that he/she has saved as the contract's default profile.

vi. Green on Black: This chart is differentiated largely by its aesthetic divergence from other charts; what
was once a chart of black lines against a white background is now one of green lines against a black
background.

a

Allows you the ability to see properties of series, removes series, Freeze Limits or Auto Limits

NOTE: the Contract chart will be the default chart unless you right-click on the Line or chart you want. You will know
the Chart has been selected because it will have points highlighted along the line itself.

~

Chart - 3 min (ESU6) Mm=Ex|

Contrack,., Add Indicator « 3 min * OHLC -

L,

High 1304.00  Low 130400

™
B

Open 130400 Cloze 130400
- 130400

Properties
b

F1302.25

F1300.30

Ser

Add Indicator 3

Period k 123873
Profile 3

Area r | Properties: Chart Area 1
Series ¥

Drawing Tools » Freeze Limits

Export , Auto Limits

Properties: Chart Area X

Will open the Properties box on the right side of the Chart. With this you can change around and customize
appearance. (SEE SELECT PROFILE > 3. PROPERTIES BOX)

Remove: Chart Area X

Will remove the selected chart from all chart area.

Freeze Limits

Freeze limit will capture the high and low prices of the currently viewed chart window. Once the prices have
been captured the viewable window will not change, therefore not allowing the chart to be viewed above or
below the high or low price which was frozen.

Auto Limits

Auto limit allows the viewable chart to adjust to the necessary prices accordingly. The high and the low of a
specific contract will adjust its scale depending on how high or low the market price diverges from the initial
median price.
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View

I . -\
# Chart - 3 min (ESU6) MR
Contrack,., Add Indicator = 3 min = OHLC -

I"\ High 1304.00 Lows 130400
b Open 130400 Close 1304.00 T
T LT Rt LT 1:30.001
W Propetties
F1302.25
| X
F1300.50
| add Indicator »
AEC Period 3 [1298.73
'Fr,.l Profile 3
1 Area 3
| Seties ¥
Drawing Toals ’ save As Default
Expork r Indicators. ..
—

Move to New Area

Once a chart indicator has been highlighted by right-clicking on the desired chart, traders can move the chart to
a new viewable window below the contract chart window. A number of indicators already start in a new chart
area . Some of the moving averages for example appear directly on the contract chart, thus being able to be
moved to a new chart area.

Save As Default

Saves properties as default for newly created series of the same type.

Indicators...

Shows the Indicator List Dialog. The Indicator List dialog allows traders to remove indicators or modify
properties of the selected indicator.

Drawing Tools
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m Chart

-3 min (ESU6)

Contract,..

add Indicator = 3 min

L\ High

Open
Y o

120275 Lows 130273
1303.73 Close 1303.73

W || B
b

Properties

Add Indicator
Petiod

Prafile

Area

Seties

12:00:43 PM .

130225

F1300.50

| Drawing Tools Finter
Export | Trend
Auto Scroll S| Line
Offset () Callout
g9 | Zoom In Chrl+1 4EC Texk
= Zoom Ot ChE+O — | Horizonkal Line
Data Box | | wertical Line
Crosshair Mode w | T Arrow
Load More Data By Send To Back
W Volume L Ering To Front
Allowe Selecting
Select Al
Pointer

Allows traders to highlight specific area by dragging the cursor. Once highlighted the trader can zoom in on the
highlighted area.

Trend

Displays trend lines with 3 lines. The standard deviation, the variance and the average. This can be adapted
by only the trends of the Chart, they are not free flowing and they are not dependent on the y axis or price.
Line

This is a free flowing chart that can be changed with not regards to either the x or y axles.

Callout

This allows traders to place call outs attached to specific high or lows at a certain time. Traders can put
whatever they desire in the call outs.

Text

Text is an option where traders can put text on the chart not dependent on anything but their text within the text
box.



View

Horizontal Line

This line can ONLY move horizontally no matter how vertical your diverge from the initial point on the line.

Vertical Line

This line can ONLy move vertically no matter how horizontal you diverge from the initial point on the line.

Arrow
Place thick highlighted arrow anywhere on the chart.

Send to Back

The options send the highlighted chart to the back of all the other charts on that same chart area.

Bring to Front

This options sends the highlighted chart to the front of all the other charts on the same chart area.

Drawing Properties

Allows you to customize the drawing properties of the previously placed drawing tools.
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# Chart - 15 min (6AU6)

Contrack,.. Add Indicator = 1t

L\ High 75.33  Low 7929
3 Open 7523 Close 75.33 I

|||| ; |

W

Contrack,., Add Indicator = 15 min * OHLC + Indicators.,, 3Select Profile -
High 7535 Lew 75.3 Vertical - @
b Open 7534 Close 733
E Appearance

W I | Colar Bl Red IHTL #

B l’}-rl —|_|-l End Cap Diamond [V] | 1 ‘ 5
W l { Mode Finite o 1 1 ‘J
| | Start Cap Arrow I 1|‘
P m Shyle F solid

H width = J{

G -
+
bt
By
Th I 05:00

@ Connected '39!'.1':' [] Save az Default I

In the example above the trader drew a vertical line then while the line or object is highlighted, left-clicked
'Drawing Properties' in the left panel to view the properties window of my vertical line. | selected Color: Red,
End Cap Diamond, Mode: Finite, Start Cap: Arrow, Style: Solid, Width:6.

Remove Drawing Object

The will remove the highlighted drawing from the chart area.
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View

Allow Selecting

When 'Allow Selecting' is checked, the trader is able to highlight or select the drawn objects in the chart by
performing a left-click on the desired object.

Select All

It will highlight or select all the objects drawn on the chart.

Export

Print

This function allows the trader to send the currently selected chart image to a printer of his/her choice.

Save Image

This allows the trader to save the currently selected chart as an image of specified file type on his/her computer
or external drive.

Save XML

This allows the trader to save the currently selected chart as an image in XML format, which is then available
for use for generation in other applications.

Copy

This allows the trader to copy the image of the currently selected chart to be able to paste into other
applications.

Auto scroll

# Chart - 3 min (ESU6)

Contrack,,., Add Indicator = 3 min * CHLC

Lx High 1303.75  Low 130373
Open 130375 Claze 130375
™

5 Properties
X F1302.25
F1300.50
| &dd Indicator 3
HEC Period 1
f__i“ 4 Prafile »
t Area k
Serips , 12:14:59 PM
Drawing Tools »
Expork k
Auko Scrall

This provides a constant timeframe for the chart. In other words, as the day progresses and the chart extends out to
the right, the data displayed on the chart will systematically progress toward the left in order to keep the most recent
data on the right side of the chart. Auto scroll can be selected (checked) or deselected (unchecked).

125



OECTraderUserGuide

126

Offset

This causes the display of the chart to have a relatively small blank area in between the most recent market data and
the far right edge of the chart. It is largely used for the increased ease in visual distinction it provides with respect to
market data. Offset can be selected (checked) or deselected (unchecked).

Zoom In (CTRL+I)

This allows the trader to decrease the amount of data viewed at one time on a chart. It allows him/her to more
closely see short-term market movements.

Zoom Out (CTRL+O)

This allows the trader to increase the amount of data viewed at one time on a chart. It allows him/her to better see
long-term market trends.

Data Box

This allows the trader to toggle the data box containing data such as market high, low, open, and close, normally
located in the top left corner of the chart on (checked) or off (unchecked).

Crosshair Mode

This option allows the user to specify how he/she would like the crosshair feature (red cross on the chart) to be
displayed.

Hidden

The crosshairs are not visible
on the chart

Free

The user must click on a
location on the chart to make
them appear. Upon
placement, they do not move
unless reassigned.

Mouse

The crosshairs move
unrestricted in conjunction
with the user's mouse
movements.

StickyClick

The vertical bar moves
somewhat freely (“stickily")
with the user's mouse
movements, but the
horizontal bar changes only
upon the user's specification
by mouse click.

Sticky

The crosshairs move
somewhat freely (“stickily")
with the user's mouse
movements.

Load More Data



View

Load more data allows the trader to increase their viewable charts by simply clicking on the load more data. This will

decrease the size of the scroll bar therefore increase the amount of data available to be viewed. The Zoom in and

Zoom out are not effected by this option. Load More Data basically provides as much data as possible on the charts,

allowing the trader to view multiple days if not weeks of data on one chart.

Volume

Select "Volume" in the sub menu.

# Chart - 3 min (ESU6)

mEx]

Volume view

Crosshair Mode

Load Mare Data

Yolume

Contrack,., Add Indicator + 3 min * OHLC * Indicators. .,
L High 130325 Low 1303 00
-4 Open 130325 Cloze 1302.00 X
N Mo T o s T T iy | L1203 .75
L WHF Add Indicakar
0 Period
| 1301.50
Profile
ARG
i Area L 1289 25
[ Series
T
| ® 2006 Open E Cip, LLC Drawing Tools
,
01:00 [ 200603 Expatt
i) @ Connected | 0j24/2006 03: At Scrol 2:76:28 PM
Offset
g8 | Zoom In Chrl+1
= | Foom ook Chrl4+D
Daka Box
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# Chart - 3 min (ESU6)

BEx]

Contrack,.. Add Indicator + 3 min

+ Indicators. .,

L\ High 1303.00  Low 1302.73
3 Open 130275 Clase 1303.00

“alume 1 t
Q

e [EIE

0100

% 2008 Open E Ciy, LLC

12375

iv| € Connected | 08242006 03:51

12:27:40 PM

Chart Properties

Properties
Current Profile

Appearance

The chart properties are fully customizable.

# Chart - 15 min (ESZ6)

mE]

Contract... #Add Indicator + 15 min * OHLC + Indicators... Seleck Profile - E | ﬁ
L, | " lispss | Propeties |Data | Indicators
b Current Profile ™
‘ b - 1
s % B Appearance A
B H 134725 Background Color [ ] White B
134575 Eackground Gradier [ | White
| B Bid/Ask
. 134425 Ak Color [ ] Silver
] L1242 75 Bid Colaor [ ] Silver =
(id Show Bid/bsk  False
t (1341559 Data Box
. Crozzhair on Mouse | Sticky
Font Arnal 6. 75 Regular
pr Show OHLC True
i Source Crozshair
4| @ 2006 Dpen E Ciy, LLC Wisibility AutoHide v
u E Grid and others B |
1001 Cursor Red, 1. Solid it
_,"" Connected | 09)26/2006 16:30 10:34:08 AM




View

Background Color

The background can be customized by selecting any color from the drop box to the right. The color will appear
on the back of the chart.

Background Gradient

This is the second color of the background. This allows the two colors to blend together. This color will be bold
in the bottom right corner while the primary color will be bold in the top left corner.

Contrack,,. Add Indicator = 15 min * OHLC » Indicators.,. 3Select Profile - n |

High 1338.25 Low 133750 1250 25 | Froperties | Data | Indicators
. Open 1338.00 Close 133775

W

P Current Profile

}<E]h|

e

EH Appearance

Background Color - [_] ‘wihite
L1345 75 Background Gradient [ | ‘White
B Bid/A| 00 | Web Suztern

F13d4.23
'ﬁ'_Sk Lo 1 Trangzparent ~
134275 Bid Col | mm Black
Show § [T Wwhite
El Data | |EE DimGray
I Gray

Erussh 1 DarkGray

ont |\ Silver
Show | | LightGray
1536 75 Source |1 Gainsboro
© 2006 Open E Ciy, LLT Wisihilt E mﬂmnke

5 Grid 3\ s D arkFied
Curzar | | il Red [

I Eirowin
,,'D Connecked | 09)26/2006 16:30 | Eirchrick [l

134723

F1341.23

D@ XG> &

Bid/Ask
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Contract... Add Indicator + 15 min * OHLC = Indicators... N
L, Properties | Data | Indicators
H1350.25
b Current Profile w
e (134300 '8 Appearance
Backaground Color [ white
5 H1247 .75 . .
Background Gradient [ | ‘white
| jsacsp | B Bid/Ask
e Azl Color [ Silver
6 F1345.25 Bid Color [ Silver
i Show Bid/aak False
+ r1344.00 B Data Box Tre
. Crozzhair on Mouze  [Falze
i H3d2 75 Fant
Show OHLC True
F1241.50
X Source Crozshair
B 1340 25 Visibilty AutoHide
gt f 1 E Grid and others
Ask Color
The color of the Ask price on the Y axis.
Bid Color
The color of the Bid price on the Y axis.
Contrack,,. Add Indicator = 15 min * OHLC = Indicators.,. Select Profile - E | "
High 1347.75  Low 134725 Properties | Data || Indicators
Open 1347 .25 Close 134775 L1343 25 -
“ I Current Prafile v
| |
B % Background Gradient [ | ‘white -
) B Bid/Ask
134523 Aszk Calar [ Silver
I s Bid Color [ Silver
AEC . Show B £ ysrom | Web
i F1341.25 E Data [ Tranzparent S
o Crossh| | S Black
+ Font | |3 Wwhite
. Show (| | B DhirnlGray
ik 1337 25 S ourcd E Efaiﬁ
o] s s opnt ey =
| E Grd g | LightGray =
By Y [ Gainsboro .
1 'whiteSmoke
i @ Connected | 09/26/2006 16:30 B 14 =roon dl
I [ arkRed
I Red
I Erown
[ Firehick s

Show Bid/Ask




Dat

View

When ‘False’ is present the Bid/Ask price are not visible. Click on ‘False’ and change it to ‘True’ allowing the
Bid/Ask to be viewed for the most current price.

Conkrack,.. Add Indicator ~ 15 min * OHLC = Indicatars. ., N
IE I Froperties | Data || Indicators
F1350.25
Current Prafile L
ww [1349.00 E Appearance
Background Color - [ ] ‘White
- F1347.73 . -
Background Gradient [ ] ‘White
I jsas 50 | B Bid/Ask
a Azl Color [ Silver
| 1245 25 Bid Colar [ Silver
(i) Show Biddek False
+ r1344.00 | \Fl Data Box True
. Crozshair on Mouze  |Falee
F1342.73 Fant
' 1241 50 Show OHLC True _
i Source Croszshair
By 1340 55 Visibilty AutoHide
et f 1 =l Grid and others
a Box

§
(el

Chart - 15 min (ESZ6)

BEx]

Contract... #Add Indicator + 15 min * OHLC + Indicators... Seleck Profile - _
L, | " lyaspas | Propeties |Data | Indicators
N 1345 75 Current Prafile w
R B Data Box. ~
i 134723 Crozzhair on Mouze  Sticky
L1345 75 Font Microzoft Sans Seri
| Show OHLC True
AR [1344.23 Source Crozzhair
! L y240 75 Yizibility AutoHide
'Fr” B Grid and others
t r13H.23 Curgor Red. 1. Solid
. Horizontal Tick Marksz, Grid Li
Selection Color I Gray
pre Wertical Tick Marksz, Grid Li
i B Scrolling
e Auto Scroll True
Show Right Margin -~ False
{l g d ”
_,,.'D Connected | 09)26/2006 16:30 10:21:56 AM

Crosshair on Mouse
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Contrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Select Profile -~ .-
L | 2spos | Propertties | Data | Indicators
b 1342 75 Current Profile w
R B Data Box P
i 134723 Crozzhair on Mouze  Sticky b
L1345.75 Font Hidden
I Show OHLC Free
p r1344.25 Saurce Mpuse .
- F1342.75 Yizibiliby StickyClick
Fﬁ' _:m E Grid and others | Sticky
Hidden ) ] ' T
The crosshairs are not visible on the chart
Free

The user must click on a location on the chart to make them appear. Upon placement, they do not move
unless reassigned.
Mouse

The crosshairs move unrestricted in conjunction with the user's mouse movements.
StickyClick

The vertical bar moves somewhat freely ("stickily") with the user's mouse movements, but the horizontal
bar changes only upon the user's specification by mouse click.

Sticky
The crosshairs move somewhat freely ("stickily") with the user's mouse movements.

Font

Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;
aka OHLC (Top left corner by default).
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Contrack,..  Add Indicakor ~ 15 min * OHLC = Indicators... Seleck Profile - E | "
IE I 135005 | Froperties | Data | Indicators
b | 1248 75 Current Prafile W
g Show BidAdzk Falze ~
i A9 Data Box
H1345.75 Crosshair on Mouse Sticky
| Fort Anal 6.75 Regular
L
=
0 Font: Fart style: Cizen
| Avial Regular !
) Avial | [Fegular 8 A
()} Arial Black [talic 9 SICE
pd () Arial Marow Bold 10
H Batang Bald Italic 11
| @208 Openl | BatangChe 12
ﬁ {} Eook Antiqua 14
- (} Bockman Old Style ¥ 16 ¥
v @ Connected Effects Sample
[ 5tikeout
AaBbYyZz
[ Underline ¥
Script:
Western w

)(E]hl

Show OHLC
The Open High Low Close is by default displayed in the top left corner. It tracks the data that your mouse is
moving over.
Contract, .. Add Indicator = 15 min * OHLC » Indicators,., Select Profile - E |
L, | ssps | PToRetties | Data | Indicators
~ 1242 75 Current Profile
e Show BidAdsk False
R 13472 E Data Box
134575 Croszhair on Mouze Sticky
| Font Anal 6. 75 _Regular
P [laad.23 Show OHLE Tiue
- Hade 75 Source True
(id I W Wisibility False
| “ 134125 M Peid amd nthnen
Source

Provides the type of data that will appear in the OHLC box in the top right corner.
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Contract... Add Indicator = 15 min * OHLC + Indicators... Seleck Profile - H | "
L, | aspss | PTOREtties | Dats | Indicators
i P Current Prafile W
o, El Data Box -
F1347 .25 . .
B Crozzhair on Mouze Sticky
H1345.75 Font Arial,6.75. Reqgular
I Show OHLC True
. 134423 Source Crozzhair
{T‘ F2d2 75 l'-.-"ISI|:II|I|I_|,| Last
i E Gnd and others |Mousze
t Curzor Crozzhair
{ o R I P A | L o L
Last
The most current data presented in the OHLC.
Mouse
Presents the data from the location of your mouse on the chart.
Crosshair
Presents the strict data from exactly where the crosshairs are in relation to the contract chart.
Visibility
Contract, .. Add Indicator =+ 15 min * OHLC » Indicators,., Select Profile - E | N
High 1347.75 Low 1347 35 125025 | Propetties | Data | Indicators
Open 134750 Close 134725 -
™. P Current Profile v
W 1 WM DataBox ~
B | Crozshair on Mouze Sticky
F1345.75 Font Arial,6.75.Regular
I Show OHLC True
A 134423 Source Crosshair
| L1542 75 Wisibility AutoHide
(i) B Grid and others [Visble
t 134123 Cuirgar Hidden
. l_1333 15 Harizantal AutoHide
= |1 | I C mlmmbiman T Alar T——
Visible
The OHLC will always be on the chart.
Hidden
The OHLC will never be on the chart.
AutoHide

The OHLC will hide when the cursor is off the chart and will appear when the cursor moves over the chart.

Grid and Others
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View

& Chart - 15 min (ESZ6) =Jo&d
Contract,.., Add Indicator = 15 min * OHLC * Indicakors... Select Profile - E | ok
LIl High 134550 Low 134375 Froperties | Data | Indicators
0 134475 CI 1344.00 L —
= i 134875 Current Profile “
Nk W 1346.50 Visibility AutoHide A
N =H and
134375 ursor Red. 1. Solid
| L1242 on Harizomtal Tick Marks. Grid Lines
AEC Selection Calar I Gray
| 133375 Yertical Tick Marks. Grid Lines |
Ff’ B Scrolling
t | @ 2008 OpenE 1 Auta Sl True
5 pen € Ly, Show Right Margin -~ False u
k] 20061002 10:30 .v.
,!D Connected | 0902612006 16:30 10:46:44 AM
Cursor
General Information about the Crosshair.
#! Chart - 15 min (ESZ6) M=
Contract,., Add Indicator = 15 min * (OHLC » Indicators,.. Select Profile - E | CH
Lol High 133050 Low 133835 Properties | Data | Indicators
Open 1339.25 Close 1338.50 F 128,00 - —
b Current Profile w
W 1346 25 Visibilty AutoHide ~
) B Grid and others
(13508 Cursor Red. 1. Solid
| Color I Red
ARG Shyle = solid
| "wiidth =
Gf’ ® Horizontal Tick Marks, Grid Lines _
t 2006 Qpen E Cry, LLC Selection Color I Gray j |
i Wertical Tick Marks. Grid Lines |+ |

|'D Connected | 09/26/2006 16:30

10:51:23 AM

Color

Specific color of the crosshair.

Style

Specific style of the crosshair whether it be a dotted line, a dashed line, a solid line, etc.

Width

The thickness of the cursor

Horizontal
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# Chart - 15 min (ESZ6) =JoJed
Contrack,.. Add Indicator = 15 min * OHLC = Indicators... Select Profile - E | qp =
[ Propeties | Diata | Indicators
b Current Profile ™
s 134875 El Grid and others A
i 1347 25 Curzar Red, 1, Sohd
El Harizontal Tick Marks, Grid Lines
| m Show Grd Linez  True
2EC E Gnd Lines LightGray, 1, Dash
] F1344 25 Calar [ LightGray
F{l Shyle -1 Dash
t r1342.73 "width =
. Label Color I Elack
134123 Label Font Microzoft Sans Serif. 7 _Regular
Show Tick Marks  True
F1333.75
x E Tick Marks Black. 1. Solid
By L1ang 25 Calar I Elack
ﬁ Style E] 5olid
H1336 75 width 1
@ 2006 Open E Ciy, LLC Sele:cticln Color - Gray o
Wertic:al Tick Marks, Grid Lines A
10401 1003 E Scrolling hd
& Conmected | 09/28/2006 16:30 1:28:54 PM
|

Show Grid Lines

Shows the horizontal grid lines. In order to turn the horizontal grids lines off switch ‘True’ to ‘False’.

Contract,,, &dd Indicator = 15 min = (QHLC = Indicators,., Select Profile = ﬂ | b = 5
E I Properties | Data || Indicators
Current Profile v
W B Grid and others A
i Curgor Red. 1, Solid
=l Horizantal Tick Marks, No Gnd Line:
| Show Grid Lines  False
s Grid Lines True
Label Color Falze
G) 1 I akal Farmk
\
Grid Lines

General information about the horizontal grid lines.
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View

# Chart - 15 min (ESZ6)

M=%

Contract,,. Add Indicator = 15 min * OHLC = Indicators,.. Select Profile - ﬂ | d8 = A
E Froperties | Data | Indicators
b Current Profile ™
e ﬁ;\ E Grid and others A

i & Cursor Red. 1. Solid
El Horizontal Tick Marks,. Mo Grid Line:
[ Show Grid Lines  False
AEe = Grid Lines LightGray, 1. Dash
| 134123 Colar ] LightGray
"?{' | 1239 25 Style =] Dash
t fidth |
i F1337.23 Label Calor Il EBlack
@ 2006 Dpen E Cryp, LLC Label Fant Microsoft Sans Serif,7.Re
Show Tick Marks True [ |
P 1001 10003 i P e ]
|'O Connected | 09/28/2006 16:30 1:37:42 PM
Color
Specific color of the horizontal grid lines.
Style

Specific style of the horizontal grid lines whether it be a dotted line, a dashed line, a solid line, etc.

Width
The thickness of the horizontal grid lines.

Label Color

The color of the labels on the horizontal axis (Time)
Label Font

The font of the labels on the horizontal axis
Show Tick Marks

Shows ticks from the horizontal line to the labels. Can change visibility of the horizontal ticks by changing
‘True’ to ‘False’.

Tick Marks
General information about the Tick Marks.
# Chart - 15 min (ESZ6) M=}
Contract,,. Add Indicator = 15 min * QHLC + Indicators.., Select Profile - E | g = A
E I I Froperties | Data | Indicators
., 134925 Current Profile ™
W 1247 50 E Horizontal Tick Marks. No Grid Line::A:
i Show Grid Lines  False
WErEE | O GiidLines LightGray, 1, Dash
| L 134400 Calor [ LightGray
A Style -] Daszh
| “idth —
(i} LabelColor [l Black
+ Labeel Fart Microzoft Sans Sernif. 7 .Re
— F238.75 Show Tick Marks True
B Tick Marks Black. 1. Solid
1o Cal Il Black
7| © 2006 OpenE Ciy, LLC o
' pent L. Siyle F solid
" 101 10/03 Wl B 1 d]
'lo Connected | 09)258/2006 16:30 1:41:40 PM

Color
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Specific color of the ticks on the horizontal axis
Style

The style of the ticks on the horizontal axis
Width

The thickness of the ticks on the horizontal axis

Selection Color

The color you desired for the selected area if you were to drag you cursor from one point to another

Vertical
@4 Chart - 15 min (ESZ6) M=
Contract,.. Add Indicator = 15 min * OHLC = Indicatars... SelectProfile ~ [ | 4= = J
IE I Properties | Data || Indicatars
., Current Profile ™
b Selection Color 2 Gray ry
i B “ertical Tick Marks, Grnid Lines
Show Grid Lings  True
| E Grid Lines LightGray, 1. Dazh
Ara Colaor [ LightGray
[ Shile =1 Daszh
(i} ‘widkh =
t Label Calar Il Elack
— Label Font Microzoft 5ansz Serif, 7 Re
Show Tick Marks True
P 4227 00 Bl Tiu:lEQ h|-1arks 2:::;,' 1,k5|:|lid
& alar ac
gy, & 2006 Opan E Cw. LLC Shyle = Solid |
T 1001 10:02 idth = ]
i 3 Connected | 09/28/2006 16:30 1:43:46 PM

Show Grid Lines

Shows the vertical grid lines. In order to turn the vertical grids lines off switch ‘True’ to ‘False’
Grid Lines

General information about the vertical grid lines
Color
Specific color of the vertical grid lines
Style
Specific style of the vertical grid lines whether it be a dotted line, a dashed line, a solid line, etc.
Width
The thickness of the vertical grid lines
Label Color

The color of the labels on the vertical axis (Time)
Label Font

The font of the labels on the vertical axis
Show Tick Marks

Shows ticks from the vertical line to the labels. Can change visibility of the vertical ticks by changing ‘True’
to ‘False’
Tick Marks

General information about the Tick Marks
Color
Specific color of the ticks on the vertical axis
Style
The style of the ticks on the vertical axis

Width



View

The thickness of the ticks on the vertical axis

Scrolling

# Chart - 15 min (ESZ6) M=)
Contract,.. Add Indicator = 15 min * (QHLC = Indicators.,. Select Profile - E | g =

L | ' I Properties | Data | Indicators

b [1348.73 Current Profile ™
s Source Croszshair A
8 Wigibiliby AutoHide

Grid and others

I , Cursor Red. 1. Solid
ARD Harizontal Tick Marks, No Grid Line:

| Selection Colar I Gray
(i (T Vertical Tick Marks, Grid Lines

t L1337 50 1q ; =
= Ao Scroll True

2 2006

OpenE Ciy. LLC Show Right Margin | False |
Pt 1041 10,03 s

," Connected | 09/28/2006 16:30 1:46:35 PM

Auto Scroll

Keeps the horizontal scroll bar at the bottom always at the most current price or at the most far right price
Show Right Margin

Offsets the scroll bar so the margin between the Y axis and the most current price is viewable
Chart Area 1

Misc

'@ Chart - 15 min (ESZ6) mEx)

Contrack,,, Add Indicator = 15 min - OHLC = Indicatars,,. Seleck Profile - E | g =

L || High 134775 Low 134725 Froperties | Data | Indicators
W

Open 1347 .25 Close 134775
S Chart &rea 1

T I n'
H
W= R "i’ B Misc

Cuztom Les [Collection]
Lower Limit Auto
|lpper Limit Auto

134,25

F13d2.00

AR
(i) F1339.75
1 H1337.50

1:43:29 PM
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Custom Levels

Lower Limit

Allows you to set a specific price at which your viewable chart will not move below.

Upper Limit

Allows you to set a specific price at which your viewable chart will not exceed.

Contract (ei: ESZ6)

Appearance

-~

Chart - 15 min (ESZ6)

BEx]

Conkract...

Add Indicatar « 15 min

+ Indicators.., Seleck Profile - E |

L,

High 1333.30  Low 133300

™
W

XB| > B

Open 133925 Cloze 1339.50

ST

% 2008 Open E Cryp. LLT

1347 .75

1347.00

-1245.75

F1343.73

F1241.75

[z 7] [T

," Connected | 09/2212006 17:15

Properties | Data

ESZR

E Appearance
Chart Style
Color
Styles
"izible

B Candlestick
Bearizh
Bullish

EH Mizc
Sezsion

Indicators
—

Spline [w]
Il Elack
[Collection]
True

Il Red
Bl Green

24 hours

£:04:25 PM

Chart Style

Select the style of the chart you wish to view whether it be OHLC, Spline, Candlestick, Area, Stepline, etc.

Color

The color of the main contract chart

Styles

The specifics of the main contract chart

Visible

Whether or not the main contract chart is viewable

Candlestick



View

§
(|

Chart - 15 min (ESZ6)

BEx]

Conkract... &dd Indicator - 15 min = Spline = Indicators,.. Seleck Profile - E |
Ll High 134550 Low 134525 i Properties | Data | Indicatars
u] 1343.50 CI 1345.25 .
~4 Jiﬁ}‘- ’r'lll FSE 1347 75 ESZE L
s ‘L h\ M B Appearance
B : Chart Style Spline
W | 1343 75 Colar [ | Bla_ck
| Styles [Collection]
AEC F1341.75 Yizible True
! B Candlestick
'Fr” r1339.79 Bearizh B Red
t Bullish Bl Green
Session 24 hours
P
,'D Connected | 09/22/2006 17:15 2:15:52 PM

Bearish

The color of bearish candlesticks

Bullish

The color of the bullish candlesticks

Misc

Conkrack, ..

add Indicator = 15 min

b
B

X |2 &

High 134850  Lows 1348.00
Open 134825 Close 1348.25

g W’YW

2 2006 Open E Cry, LLC

_ig)

,'D Connecked | 09/22/2006 17:15

Session

RO ZO0E 002 05:15

25,
* Spline - Indicatars... SelectProfile ~ [ | & =
i Properties | Data | Indicatars
ESZ6 v
El Appearance
Chart Style Spline
1344 50 Color Il Black
Stylez [Collection]
1342.73 Visible True
B Candlestick
F1344 .00
Bearizh Bl Red
132925 Bullizh Bl Green
B Mizc
133750 Session 24 hours
(*) 24 hours
() Caontract Setup
() Custam

The time span you wish to view the chart
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24 hours

24 hours a day will be viewable
Contract Setup

The session will include only from the contract opening till the contract close
Custom

Select the time session you wish to view the contract
Additional Indicators

Appearance

andleSkick, | Indicators,., Select Prafile -

Properties | Data | Indicators |

BB and[Close:ESZE,20:2)
ESZE
|EBard(Close:ESZE20:2)

12000 ErdCloze:ESZE,20)

BB and[Cloze:ESZE,20:2]

1336.50 Stdlew|Cloze:ESEE, 20

Triple[StdD e [Close: ESZE,20),13:9:4
ATRIESZE14]

Orders

£

S:03:26 PM .

Select Profile -~

sndleskick + Indicakors...
||

Chart Style

154000 Calor B DeepPink
Styles [Collection]
1640 Visble  True
E Data
| Fipik Close:E5SF6

Period of indi 20

S:05:44 PM




View

Chart Style

The style of line the indicator chart will have, whether it be line, area, point, spline, etc.

Color

The color of the indicator chart

Styles

Specifics of the indicator chart

Visible

Whether or not the indicators is viewable

Data
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andleskick, | Indicakors,., Select Praofile -

Properties | Data | Indicatars |

BEand(Close:E 526.20:2)
ESZE

124000 E A Close:ESER,20]
BB and[Cloze:ESER,20;2]

1236 50 StdDev|Cloze:ESZE,20)
Triple[StdDey [Close: ESZE,20),18;9:4
ATRIESZE14]

Orders

W

5:03:26 PM :

ondlestick. = Indicators,., Select Prafile -

E Appearance

Chart Style  Line
1340.00 Calar B DeepPink
Styles [Collection]
13650 Visible  True

Close:ESS6
20

S:05:44 PM .

Input

Depending on the indicators, the data the indicator is having the information input from.
Period of indicator
The amount of data the indicators is viewing its information from based on the time or period indicated
Orders
Appearance

Font
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View

Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;
aka OHLC (Top left corner by default).

# Chart - Bollinger Band: 15 min (ESZ6) =J0)e3d
Contract,., Add Indicator = 15 min * (OHLC » Indicators,,, Select Profile - E | CH
L 1 | :
IE Properties | Data | Indicators
b Orders ™
o B Appearance A
i Font Arial 6. 75 Regular [..]
E Color of Text
| Cancel Com [JJll DarkRed =
133675 .
ARG Color of Fill: [JJl] Black
| Modify Corr [JJll DarkBlue
Gf’ o0 1o Fjl Harmal Orde [l Black
t B Filter
i Cancel Com Falge
= Cancelled O False
e Completed C True
] Fills Falze ]
!i MMJ\\ /ﬂ—/\. bl o X, T .v.
'!' Connecked | 09/20/2006 16:30 22706 PM
Color of Text
#! Chart - Bollinger Band: 15 min (ESZ6) M=
Contract,., Add Indicator + 15 min = OHLC + Indicators... Select Prafile ~ E | o8
Ll High 134100 Low 134075 Properties | Data || Indicators
~4 Open 134100 Close 13400 Orders 'v'
e Ebda 1340738 EH Appearance
_§ ATR 0.3 Arial.6.75.Regular
| Cancel I:::umm-- DarkRed =
. Color of Filz: [l Black
Modify Comm: [l DarkBlue
Ff’ TR Homal Order [l Black
t = Filter
. Cancel Comm. False
Cancelled Ord Falze
Completed Ore True
X o Fill= Falze ]
By M \\ YT = = il
," Connecked | 0972072006 16:30 2:29:00 PM

Cancel Command

The color of the text in an order indicator will appear by default Dark Red for cancel commands

Color of fills

The color of the text in an order indicator will appear by default Gray for Fills
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Modify Command

The color of the text in an order indicator will appear by default Dark Blue for Modify Commands

Normal Order

The color of the text in an order indicator will appear by default Black for Normal Order

Filter

# Chart - Bollinger Band: 15 min (ESZ6)

BEx]

Contract... &dd Indicakor = 15 min = OHLC = Indicatars... Select Profile = [ | €&
L High 134900 Low 134825 Froperties | Data | Indicators
o Open 134250  Close  1348.30 Orders 'v'
W e 1940 500 B Fiiter ~
M &TR 168 Cancel Comm. False
Cancelled Ord False
| Completed Ore True
ARD Fill= Falze
kadify Comme False
(i Rejected Orde| Fal =
o T ot jected Urde Falze =
t Yizible True
. Wiorking Orde Falze
Format
pYe Agagregated Fi False
- ’\ F&/\( Full Format Falze ]
By @ & 908 NpenE.Ci 11 VIS = lud
,'i Connecked | 09/20/2006 16:30 Z:35:42 PM

Cancel Commands

This option offers the ability to view cancel commands on your chart, by default they are off.

Cancelled Orders

This option offers the ability to view cancelled orders on your chart, by default they are off.

Completed Orders

This option offers the ability to view completed orders on your chart, by default they are on.

Fills

This option offers the ability to view fills on your chart, by default they are off.

Modify Commands

This option offers the ability to view modify commands on your chart, by default they are off.

Rejected Orders

This option offers the ability to view rejected orders on your chart, by default they are off.

Visible

This option allow traders to turn the orders on or off without manually going thru each individual filter type. If
traders want to turn the viewable filters off simply change ‘True’ to ‘False’.




View

Working Orders

This option offers the ability to view working orders on your chart, by default they are off.

Format
#! Chart - Bollinger Band: 15 min (ESZ6) M=
Contract,., Add Indicator = 15 min = OHLC + Indicators... Select Prafile - E | b

L 1 | .

IE Froperties | Data | Indicatars
b Orders ™
H badify Cormme: Falze A
B Rejected Orde False

Wizible True
| Working Orde False

ARG = Format

| Aggregated Fi Falze

Ff’ ,jm o prot Full Format  Falze
t Order 1D Falze
— Frice Falze =
Cuartity True
e Ticket # Falze

i ’\\ /_f Type Falze ™

58 Mﬂt )

i € Connected | 09/20/2006 16:30 2:37:07 PM

Dat

Aggregated Fills

Shows each individual quantity and the price they traded at. They are faint grey color to indicate that they are
aggregated fills

Full Format

Indicates the type, the quantity, the contract and the side of how the trade was placed
Order ID

Price

Provides the price of the trade in the viewable filters

Quantity

Provides the quantity of the trade in the viewable filters

Ticket #

Provides the ticket number accompanied by the full format indicators in the viewable filters

Type

Provides the type of order that was placed in the viewable filters.

Data

a
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Information on the chart in relation to the cross-hairs on the charted contract.

0 Cu
~

Cortract,.. &dd Indicakor = 15 min = OHLC = Indicators... Select Profile = [ | <& =
1
High 133300 Low 133825 Properties | Data | Indicators
k. Open 133350  Close  1339.00
e ERds 1339155 DatedTime 06:4510/03
ATR 095 Last update 14:38.35
T Chart Area 1
| High 1339.00
Lo 1338.25
AED Open 1333.50
| Claze 1339.00
O L Ee— Top 1341 781
t Bottarn 1336.544
s Ebda 1339155
=8 Chart Area 2
StdDew 1.3
> -/\4 Chart Area 3
o o ,ETLE:\ u ATR 0.96
i €} Connected | 09202006 16:30 213537 PM
Date/Time

The time and date where the cross-hairs cross the X axis (bottom axis).

Last updated

The time the entire contract was most recently update with new data.

High, Low, Open, Close

The data is determined by the location of your cross-hairs on the chart. If the cross hairs are below the chart
they will cross at the low on the Y axis. If the cross hairs are above the chart they will cross at the high on the Y
axis.

Indicators
Channels

Channels
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View

# Chart - Bollinger Band: 15 min (ESZ6)

mE]

Contract,..

Add Indicatar = 15 min

T OHLC

+ Indicators,,, Select Profile -~ H |

IE.'

135025 | Properties | Data Indicatnrsl

Flags Ul

F1340.00

F1336.30

@ X B> & = | 7

(¢

= Channels

= Moving Averages

J

”
Bollinger Band

Commadity Channel [ndex
Ernvelopes

K.eltner Channel

Ewponential Moving Average
Leaszt Square Moving Average
Ralling Moving Average
Simple Moving Average
Triangular boving Awverage
Triple Maoving Average

Yariable Moving Awveraoe
I |12

[v]

_,!' Connected | 092002006 16:30

4121139 PM

Bollinger Band

Will put a Bollinger Band on the chart directly

This indicator can be used to measure the relative highness or lowness of price.

Contract...

add Indicatar + 15 min

* OHLC

= Indicators... Select Profile = [

=l X

o)
IE Properties | Data | Indicators
., i IE}\P—'—’ . E! = Channels -
o . Ballinger Band L
Bollinger Band = @ Commadity Chantel Index I
p B El Appearance Ervelopes
| Colar [ LightBlue K.eltner Chatinel
- Yizible True wing Averages
4 B Data E=ponential Maoving Average
'Fr” B stdes 2 Least Square Maoving Average
3 [nput Close:ESZH | || Falling Maving Average
Period of indicator 20 Simple Moving Average
:‘_ Triangular Moving Average [V]
& i [
L Z141:41 PM
[ Save az Default
(]9 l [ Cancel

[ ] Create Mew Area
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Com

modity Channel Index

Will put a Chart below the existing Contract chart.

Compares Prices with its moving average.

Contract... Add Indicator = 15 min * OHLC

» Indicators... Select Profile - H

X

High 134773 Lows  134€.00

Properties | Data | Indicators

\\ Open 134750  Close 134675 ~ Channels
& Ehd 1345 476 BD"ir‘lgEr Band
- - Commadity Channel [ndes
= B Commodity Channel Index @ Envelopes
| B Appearance ||Feltner Charnel
Chart Style Line * |wing Averages
ABC : o - ;
__ Color Bl DarkViolet Exponential Moving Average
(i 4 = Shyles [Collection] Least Square Moving Average
+ Yizible True Folling Moving Average
R B Data Simple Moving Average |
i [t ESZ6 Triangular Moving Average ||
E Period of indicator 20 B
iy @ 2:52:27 PM
[] Save az Default
(] l [ Cancel
Create Mew Area
Envelope

Will apply a envelop directly on the contract chart.

Plots above and below the moving average at a specified percentage.
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View

m o
oy
Contract... Add Indicator + 15 min * OHLC + Indicators... Select Profile - E .-
High 133850  Low 1337.50 Properties | Data | Indicators B
0 133850 Ol 1338.00 —
b pen "=e - Channels ~
- ]
Ballinger Band
& Envelopes @
P Commadity Channel [ndes
e i E Appearance || Erwelopes
| Calar [ LightCoral * || Keltner Channel
) Yizible True oving Averages
CBE Data E=ponential Moving Average
(i Irput Close:E576 Least Square Moving Average
+ Percent 01 Ralling Maving Awerage
B Period of indicatar 20 Simple Moving Average B |
] Triangular Maoving .-'-‘-.'-.ferage_ s
K £d
iy § 2:55:01 PM
[ Save az Defaul
(]
[] Create Hew Avea ] [ Gance

Keltner Channel.
Will apply 3 lines to the Contract chart

This indicator shows a central moving average line plus channel lines at a distance above and below.
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" | _[=]E3
Contract,,.  Add Indicator = 15 min * OHLC » Indicators,,, Select Profile - E N
IE I Properties | Data | Indicators
™ W = Channels ”~
N s Ballinger Band 1
Keltner Channel = @ Commodity Channel Index 3
B El Appearance Ervelopes
| Chart Style Line keltrner Channel
P Clar [ DarkGray ¥ing Averages
Styles [Collection] E=ponential Maoving Average
FIJ Wizible True Leazt Square Moving Average
+ E Data Ruolling Moving Average
_= B dewiations 1 Simple Moving Average
[ [put ESZFG Triangular Moving Average
Period of indicator 20 Trinle bAvinn &werans
20 3 i 2]
& 2:57:17 PM
[ 1 Save as Default
[] Create New érea Rl l [ Gece

Moving Averages

# Chart - Bollinger Band: 15 min (ESZ6)

mEx]

Contract... Add Indicator ~ 15 min * OHLC + Indicatars... Seleck Profile - E |
Ll Hih 134700 Low 134675 r Froperties | Data | Indicators .
\\ Open 134700 Close  1347.00 = Huving .ﬁ.?ElagES [A]
Wl Eme 1348512 | 14"""' Expanential Moving Average
o Least Square Moving Awerage
| stow 0.66 hdedian 0.57 1240.00 Falling Maoving Average =
| Fast nas ATk ':' 33 Simple Moving Average
- 1336.50 Triangular Moving Awverage
Triple Moving Awverage
i?r.a Wariable Moving Awverage
4 e Wwheighted Moving Awverage
3 ' ; = DOscilliator
el Average Directional Index
g D etrended Price O scillakor
X o F b ormentum i
By @ wM m <] i 2]
_" Connected | 09/20/2006 16:30 4:40:37 PM

Expone
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View

Will apply a line direct to Contract Chart.

EMA is an average of data calculated over a period of time where the most recent days have more weight.

Contrack,.. Add Indicator « 15 min * OHLC + Indicators.,. Seleck Profile - E N
{_L | hoh 1mers  lew tmzsnl | [ | Properties | Data | Indicators
Exponential Moving Average @ Ervelopes A

K.eltner Channel

E Appearance i
- Moving Averages

Chart Style Line v : _
Color Il DeepPink Exponential Muvmg Awerage
Styles [Collection) Lea:st Squar_e Moving dwerage
Wisible True Fl.nlllng an.lng Average

El Data Slmple kaving r-’-‘-.verage
[FpLat Close:ESZ6 Tr!angular Huvmg Average
Period of indicator 20 Triple Maving Average

Yariable Moving Average
Wieighted Moving Average

+ Merilliabtnr

< 2]

FESZEPM

[] Save as Default
[] Create Mew Area [

(] 4 l [ Cancel

Least Square M.A. (LSMA)
Will apply a line direct to the Contract chart.
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Contract,.. #&dd Indicator + 15 min * OHLC - Indicators... Select Profile - [ N

(,EL-. . lm Froperties | Data | Indicators
~ =

Least Square Moving Average @ Errvelopes ~

K.elner Channel

B Appearance - Moving Averages

Chart Style Line Ld Exponential Moving Average
Coalar ] PI“_'“ Least Square Moving Average
S_t_'r'_|ES (Collection) Ralling Maoving &verage
Yisible True Simple Moving Awerage

E Data Triangular Moving Average
[npuit _ E_"-"“’:ESEE Triple Moving Average
RegrezgionOrder Linear “Wariable Maoving Average

= Pgrmds Weighted Moving Average
Window 35 + Merilliabtnr :

< 2

2110 PM

[] Save az Default
[] Create Mew frea

Ok l [ Cancel

Rolling M.A. (RMA)
Will apply line direct to Contract chart.
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View

Cantract... Add Indicator = 15 min ~ OHLC - Indicators... SelectProfile - [ L
IE I Properties | Data | Indicators

*i\.r?‘*ie\'\\ h IR Lisgeen | Ervvelopes

Rolling Moving Average @ Keltner Channel

- Moving Averages
Esponential Moving Awverage

:>:E]h

-

E Appearance

Ll s e Line . bl Least Square Moving Average
Color Bl BlueYiolet . .
. Fiolling Moving Average
Styles [Collection] . .
= Simple Moving Average
Wizible True . .
Triangular Moving Awverage
E Data . .
Triple Moving Awverage
| npit Close:E576 . .
K 0.1 W ariable Moving Awverage

Yweighted Moving Awverage
_# Mecilliatar

2 2]

F126:56 PM

[] Save as Default
[] Create New Area

(] l [ Cancel

Simple M.A. (SMA)
Will apply line direct to Contract chart.

The average of data calculated over a period of time.
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Conkrack,.. Add Indicatar = 15 min * OHLC

+ Indicatars... Select Profile - E _

IE.
™

=
-

Simple Moving Average

A
=3

B Appearance
Chart Style Line v
Color [] DarkSeaGreen
Styles [Collection]
Wizible True
B Data
[ npLat Cloze:ESZ6
Perniod of indicator 20
[] Save az Default
[] Create Mew fArea [ ok ] [ Gages

Triangular M.A. (TMA)

Direct line onto Contract chart

Properties | Data | Indicators

k3 Zk

Ervelopes
K.eltmer Channel

- Moving Averages
Exponential Moving Average
Least Square Moving Average
Ralling Moving Average
Simple Moving Average
Triangular Moving Average
Triple Moving Average
Warable Moving Average
Wweighted Moving Awverage

+ Merilliatnr

3 2]

313039 PM

Average calculated over a period of time where the middle portion of the data has more weight.



Conkrack,,. Add Indicator = 15 min

 OHLC

View

= Indicatars,.,. Select Profile - H _

m_i '“

Triangular Moving Average

2X]

B Appearance
Chart Style Line v
Colar Bl Green
Shyles [Collection]
Yizible True
B Data
Input Close:ESZ6
Period of indicatar 20
[] Save az Default
[] Create Mew fres Ok ] [ Cancel

Triple M.A.

Properties | Data | Indicatars

Envelopes
F.eltner Channel

- Moving Averages
Exporential M oving Average
Leazt Square Moving Average
Ralling Maoving Awverage
Simple Moving Average
Triangular Moving Awverage
Triple Maoving Average
Wariable Moving Awverage
Weighted Moving Average

+ Merilliatnr

< 2]

313407 PM

Applies 3 lines on Contract chart, the Slow, the Fast and the Median.
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Contract,.. Add Indicator = 15 min * OHLC + Indicators... Select Profile - E - |
High 134000  Lows 1339.00 Properties | Data | Indicators
~4 Open 133373 Close 133925 1346 50 Erwelopes A

. = K.eltner Charnel

Triple Moving Average @ - Moving Averages

E Appearance Esponential Moving Average
Chart Style Line | Leazt Square Moving Average
Calar Bl Red Folling Moving Awerage
Styles [Collection] Simple Moving Average
Wizible True Triangular Moving Average

= Data Triple Moving Average
[nput StdDev[Close:E5S6.20) “ariable Moving Average

B Periods Weighted Moving &verage
FaztPeriod 4 + Merilliatnr !

: . < >
kedianPerniod 9 — =
SlowPeriod 18 335146 PM

[] Save az Default
(]
[] Create Mew Area l [ Lancel

Variable M.A.
Will apply line directly to Contract chart.
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Contract... Add Indicator + 15 min * OHLC

View

+ Indicators.,. Seleck Profile - E -

High 1340.00

4 Open 133873

Lowe 1338235
Cloze 133323 “

1346 .50

-

Variable Moving Average @

E Appearance
Chart Style
Color
Styles
Wizible

B Data
Sensitiviby
YWaolatility B atio

[] Save az Default
[] Create Mew frea

Line )
I Chocolate
[Collection]

True

0.078
StdDev[Close:ESZ6.20]

] l [ Cancel

Weighted M.A.

Direct onto the Contract chart.

Properties | Data | Indicators

Envelopes
F.elner Channel

:>.E]h

- Moving Averages

+ Merilliabtnr

.<.

E=ponential Maoving Average
Leazt Square Moving Average
Ralling Maoving Average
Simple Moving dverage
Triangular Moving Average
Triple koving Average
Yariable Moving Average
Weighted Moving Average

2]

FINETPM

An Average where the greater weights are attached to the most recent data, it is calculated from the sum of the

day.
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" ) _ =3
Contract,.. Add Indicator = 15 min * OHLC + Indicators,.. Select Profile - E - |
High 134325  Low 1341.50 Properties | Data | Indicators
\\ Open 134200  Close  1342.00 m 1346 50 Envelupes [A]
|2 Coio 4men ong F.eltner Channel
Weighted Moving Average = @ = Moving A"'f_"ages_
Exponential M oving Average A
B Appearance : Least Square Moving Average)
Chart Style Line ] Ralling Maving &verage
Color | E'EfE" Simple Moving Average
S_t-"'_les (Collection) Triangular Moving Average
Visible True Triple Moving Average
= Data Wariable Moving Average
Inpyt . StdDev[Close:E5F6.20) weighted Moving Awerage
Period of indicator 20 = Mecilliabar bl
a )
313914 PM
[ ] Save az Default
[] Create Mew Area ok l [ Gance
Oscillator
# Chart - Bollinger Band: 15 min (ESZ6) Mi=[<
Contrack,., Add Indicatar = 15 min * OHLC + Indicators,., Seleck Profile - E | ﬁ

LAl High 134300 Low 134725 f Properties | Data | Indicators
246 25 A]

Open 134300 Cloze 134725 —
b P = Dszcilhator

Average Directional Index
Detrended Price O zcillator

b Ehd, 1347 343

I 033 Median 0.40 _ b ornernitum
| Fast 0.50 ATR IZIET3 . Perfarmance
Frice Ozcilliator =
Aa R ate OF Change
Relative Strength [ndex
A Ctochastic
wiilliar's %R
= Prices
g tedian Price
4 — f”‘“ Tupical Price [v]
By @wmw (<] m |2
_ﬂ"‘ Connected | 092002006 16:30 4:44:31 PM

Average Directional Index
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View

Will appear below the Contract chart.
Will have three lines, ADX, -DI, +Dl.

& X
Conkrack,.. Add Indicatar = 15 min * OHLC = Indicatars... Select Profile - E "
IE& N I I Properties | Data | Indicators
- | hi a1
" . . ‘| Dscilliator -
= Average Directional Index @ Average Directional |ndesx D |
B Appearance . Detrended Price Qzcillator

B Chart Style Line [l M omentum

| Colar Il Black Performance

) Shyles [Collection] Price Qzcilliator

Sl wisible True Fate Of Change

{Tr; B Data Felative Strength Index

4 Input ESZ6 Stochastic
) B Periods William's %R

S Period 14 Prices —
Trand Follnweare L
b4 Ed

| 4816 PM

[] Save az Default
C k. ] [ Cancel
reate Mew Area

Detrended Price Oscillator
Will appear below Contract chart.

The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any other
price with it's moving average.
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L
a

Conkrack,.. Add Indicatar = 15 min * OHLC = Indicatars... Select Profile - E | )
IEI | ! Properties | Data | Indicators
~ %_\ - Dscilliator A

- Average Directional Index
Detrended Price Oscillator @ Detrended Price O scillator
B Appearance - b ormentum
Chart Style Line || F'E.!rfl:urmarTc.e
Calar [] DarkSeaGreen Price Ozcilliator
Styles [Collection] Fate Of Change
Wisible True Relative Strength [ndes
E Data Stochastic
Imput Cloze:ES5Z6 _ Wwilliam's %R rvs
Period of indic.ataor 20 I+ Prices R
£ ¥
3:50:49 PM
[] Save az Default
LK l [ Cancel
Create Mew Area

Momentum

Will appear below the Contract chart.



Contrack,,, Add Indicator = 15 min = OHLC

-

View

Sl
Ca

Indicatars... Select Praofile = E |j

Momentum

E Appearance
Chart Style
Calar
Shyles
Wizible

E Data
Input

E Penods
findon

[] Save as Default
Create Mew Area

Line v
[ YellowGreen
[Collection]

True

Close:ESZB

35

k. ] [ Cancel

Performance

Will appear under the Contract chart.

Fr

[+l Prices

.(.

operties | Data | Indicators

= Ozcilliator -~
Awerage Directional Index '
Detrended Price Dzcillator
b omenturm
Performance
Price Osciliator
Rate OF Change
Relative Strength Index
Stochastic
wiilliarn's =R

(2]

3192134 PM

Compares the current Close (or any other price) with the first Close value. Shows how much the Close price
was changed from the beginning.
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o) D=

Contrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Seleck Profile - H |_E

High 134750  Low 124550 w Properties | Data | Indicators
| |

| Open 134373 Close 134723 . | = Dzcilliator [.ﬁ.]
Performance N Y Average Directional lndex
@. Detrended Price Ozcillator
B Appearance tomentum
Chart Style Line e Performance
Calar (I Eﬂl_dﬂmﬂd Frice Dscilliator =
Styles [Collection] Rate Of Change
Wisible True Relative Strength Index
E Data Stochastic
Input Close:E5Z6 Wwilliam's %R
[+ Prices ol
[{ ] 1 |[}]

315411 PM

[] Save az Default
Create Mew Area

Ok l [ Cancel

Price Oscillator
Will display below Contract chart.
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View

Conkrack,.. Add Indicator ~ 15 min = DHLC = Indicatars,., Select Profile - H |j

EM I m Properties | Data | Indicatars
L “ 1346 50 || = Oscilliator A
=%

Average Directional Index
Detrended Price Oscillator

Price Oscilliator

B Appearance | b amentum
Chart Style Line il Perfarmance
Calar Bl Red Price Oscillator
Shyles (Collection) Rate OF Change
"Wizible True Relative Strength Index
B Data Stochastic
Input Close:ESZB william's %R )
Movingdwerage Simple + Prices b
Percentage True £ | >
B Periods — —
Fastuindow 9 Sy
Sloiafindo 26
[] Sawve az Default
C (] l [ Cancel
reate Mew drea

Rate of Change

Appears below Contract chart.
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0 o
e

Contract,,.  Add Indicator = 15 min * OHLC » Indicators,,, Select Profile - E | - |
r - =
High 133950  Low 133650 Propertties | Data | Indicators
\\ Open 133873 Close  1337.00 1346 50 ~ Oscilliator -A-
s ? Average Directional [ndex b |
Rate Of Change @. Detrended Price O scillator
E Appearance - M ornerturm
Chart Style Line e Perfarmance
Color I IndianRed Frice Oscilliator
Styles [Collection] Rate Of Change
Wigible True Relative Strength [ndes
E Data Stochastic
| npLit Close:E576 William's %R ™
Period of indicator 20 :< } |
3:57:18 PM

[] Save az Default
Create Mew fArea

ak. l [ Cancel

Relative Strength Index
Appears below Contract chart.

Compares upward movement of the Close price with the downward movement resulting in a value which ranges
from 0 and 100.
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View

m o)
.
Conkract... Add Indicator * 15 min » OHLC = Indicatars... Select Profie = [ |j

IE I ! Properties || Data | Indicators

S| :Ff Seasas - Dscilliator A
- Average Directional Index
Relative Strength Index @ Detrengded Frice Oscillator
B Appearance - t ormeritum
Chart Style Line || Perfarmance
Calor I DarkCyan Price Oscilliatar
Styles [Collection) Rate Of Change
"izible True Relative Strength [ndes
B Data Stochastic
Input ESZ6 Williarn's %R o]
Period of indicatar 20 < = 3]
35909 PM

[] Save az Default
Create Mew Area [

LK ] [ Cancel

Stochastic (%K, %D)
Appears below Contract chart.

Indicator helps to find trend reversal searching for a period when close prices is close to low price in up trending
market or close prices is close to high price in down trending market.
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| X

Contrack,., Add Indicator = 15 min * OHLC + Indicators.., Seleck Profile - E | .-
High 1340.00  Low 133825 [ Propeties | Data | Indicators
| Open 133875 Close 133825 m % ~ Dscilliator =
6 . \ Average Directional lndex
Stochastic = @ D etrended Price O scillator
B Appearance Momentum
Chart Style Line [V] Performance
Calar Bl Brown Price Dzciliator =
Shyles [Collection] R ate OF Change
"izible True Relative Strength [ndes
B Data Stochastic
[t ESZ6 Wwilliam's %R [v]
PenadD 10 =
PeriodK, 10 £3 - (2
4:05:20 PM
[] Save az Default
k. ] [ Cancel
Create Mew Area

William’s %R (%R)

Places the charting below the Contract chart.

This indicator is used to measure overbought and oversold levels.



View

° c) D=

Contrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Select Profile -~ H |_E

rlT" High 133275 Low 133?.50| | [  Properties | Data |ndic:at|:-r3|

William's %R - 18| = osciliator ]
Average Directional [ndex
E Appearance Detrended Frice Dscilat
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Median Price (Median)
Places a line directly on the Contract chart.

Mid-point value of daily prices.

Typical Price (Typical)
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Appears directly on the Contract chart.

The average value of the daily prices.

Weighted Close (Weighted)
Appears direct to the Contract chart.

Average value of daily prices, only difference is that the closing price has extra weight as the most important
price.

Trend Followers

#! Chart - Bollinger Band: 15 min (ESZ6) M=%
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MACD (MACD, Histogram, Signal)
Appears below Contract chart.

Compares two moving averages of prices. Is used with its 9 day Exponential Moving average as signal.

Mass Index (MI)
Below the Contract chart.

developed to predict trend reversal by comparing difference and range between high and low prices.

Tangent of Linear Regression (Tangent)

Appears below Contract chart.

TRIX (TRIX)

Below Contract chart.

Based on triple moving average of Closing Price and its purpose is to eliminate shorter cycles.

Volatility
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Average True Range (ATR)
Appears below Contract chart.

Measures commitment comparing the range between High, Low and Close prices .

Standard Deviation (StdDev)
Appears below Contract chart.

Difference between values (Closing Price) and average.

Volatility (Volatility)

Appears below Contract chart.

Volatility Chaikins (CHV)
Appears below Contract chart.

Difference between high and low prices, indicates the top and bottom of the market.

Volatility Ratio (VR)

Appears below Contract chart.

Volumes
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Accumulation/Distribution (A/D)
Appears below Contract chart.

Estimates the strength of price movement with the relationship between volume and prices.

Ease of Movement (EoM)
Appears below Contract chart.

Uses volume to estimate how strong the price trend is.

Money Flow Index (MFI)
Appears below Contract chart.

Compares upward changes and downward changes of the volume weighted typical prices.

Negative Volume Index (NVI)
Appears below Contract chart.
Should be used with PVI.

Changes only if the volume decreases from the previous day.

On Balance Volume (OBV)
Appears below Contract chart.
Measures positive and negative volume flows.

Volume is added if the closing price moves up and subtracted if the closing price moves down.

Positive Volume Index (PVI)
Appears below Contract chart.
Should be used with NVI.

Changes only if the volume decreases from the previous day.

Price Volume Trend (PVT)
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Appears below Contract chart.
Cumulative volume total.

Calculated by using the relative changes of the Close price.

Volume Oscillator (VO)

Appears below Contract chart.

Tries to identify any trends in volume, comparing two moving averages; one with a short period and the second
with a longer period.

Communications

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
OEC population. It also displays Risk messages such as available credit, etc.

Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD,Order would need credit of 6012.52
15D [zash available iz 37862.43 15D]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.

Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hello | have a question. A | | Danield
3:28:50 PM to DamelAw'hat iz the curent zymbol of the

mini 5P 500 7

3:29:17 PM Danielh: The curent symbaol for the mini S&P

A00 iz ESUR -

W-I0-DF Dl b D il - Tl—nde - |

In order to initiate chat with a BROKER, select their name (i.e. OECBroker9) and type your message in the open row
at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT button
and the broker you selected will receive your message. The drop box is there for your reference so you can repeat
your self with previous comments or say the same thing to a different broker by just clicking into the drop box and
selected the previously written text.

To access Chat:
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a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.
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Reports

Access Reports

Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.
Daily Fills

Shows the dalily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire OEC population. These
messages are important details from the broker involving major Futures issues.

Order Details

Provides a detailed description of each trade made and the necessary identifications for each detail within the
order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Provides the list of open orders that exist with in that account.

176



Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of OEC Trading options.

Action Feys -
File
Lagan
Logoff
Exit
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Extry W adifiers:
R apid Order Entry ]
Drepth OF b arket Order Entry Ctl [] Shit [] Al

Contract Setup Key:
Clear After Subrmit

1 | | Reset
Turn on Mew Order Canfirmation -

Restore Defaulq [ Ok, ] [ Cancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and all
the contact info for customer service and support.
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m Quick Start = E

=

HEE N BN L 1
open e cry"

Welcome to Open E Cry's direct access trading software.

We encourage vou to vizit our quick start guide and in depth uzer's
guide.

If vou have any questions please visit our Live Help or call 800-520-
5308 or 814-792-2590,

of the goftware for future reference.

A link to the quick =tart guide will be available under the "Toolbox™ menu

[l Show on startup




Toolbox

Contract List
Display the Open E Cry's Contract List web page with your default browser.

URL: http://www.openecry.com/platforms/available.cfm

Contract Margins
Display the Open E Cry's Contract Margins web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/margins.cfm

Contract Specs
Display the Open E Cry's Contract Specifications web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/contract.cfm

Glossary
Display the Open E Cry's Glossary web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/glossary.cfm
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Help

Contact Us

Display the Open E Cry's Contact web page with your default browser where you can direct questions/comments to

our staff.

URL: http://www.openecry.com/company/contact.cfm

About

Displays the current information of the platform that the trader is currently running.

m.ﬁ.hnut

HEE B BN L |
open e cry

DECTrader Demo
Yerzion 3.1.0.8

& 2008 Open E Cry, LLC
&l rights rezerved
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Open Live Account

Open Live Account (DEMO ONLY)

Demo Only
Display the Open E Cry's Online Application with Electronic Signature web page with your default browser.

URL: https://www.openecry.com/openaccount/applyonline.cfm
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Advanced Features
Advanced Orders

Order Flags
# ESZ6 - Depth of Market

%]

[

ey - & |kl |  DEmMozssao -
Oty 0l TotalPAL $1,000.00
Poz: ]

<
I 1329.00 789
13227 R
3839 122250 |
122625 T
122800 [
122775
1327 RN
N - Ees

Order Flags

(%) Mone (O GTC O FOK (O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten.

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled.

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled.

OCO Orders

OCO (One cancels other) is a pair of orders sent together.
Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

1. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

2. Atter clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

Working OCO orders are displayed in blue color by default.
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Qty: 5% TatalPAL: $0.00
m Confirm orders
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3

Buw 5 ESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

|

(m]
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% —

[ es ] [ Mo
10 1326.00
B 1552 132575
2720 132550
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132450
Left Click: OO LIMIT
| BuwMkT || Gotolast || selmkr |

Stop Limit/Trailing Stop

# ESZ6 - Depth of Market

mE]

+ | [E &

af ?é} | [l

DEMO4 7094 -

Oty 3 {:} Tatal PAL:

Fos: 0

1326.75
1326.50
1326.25
1326.00
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1326.50
1326.25

$0.00
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-

[

Buy MET ] [ o bo Last ] [

Sell MKT |

[ ] Stop Limit [ ] Trailing Stop

Factor: Factar:

0.25/%

Advanced Features
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Stop Limit (STP LMT)

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commaodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

®  No order can be guaranteed an execution

Trailing Stop (Tr STP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis

Trailing Stop (Stop Limit) order is a Stop order which “follows” the market price. By checking “Trailing Stop” checkbox
all stop/stop limit orders would be sent as Trailing Stop/Stop Limit orders.

The Control key negates this checkbox settings, so right clicking with “CTRL” key pressed sends trailing stop order, if
this checkbox isn’t checked, or sends normal stop order if the checkbox is checked.

The “Factor” value controls the minimum market price change that would case order to “trail”. Its minimum value is
one tick of selected contract.

Trailing Stop order could be sent as an individual order, or as a linked (bracket) order.
Trailing Stop order couldn’t be part of OCO orders pair.

Working Trailing Stop orders displayed in green color by default.

How to execute
1. Check the Box next to STOP LIMIT and/or TRAILING STOP.
2. The Cursor will indicate when a trailing stop/stop limit order is available

3. Right click above the market to initiate the trade

Bracket Options

Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Brackets are group of orders — master and 1 or 2 linked. Linked orders are activated when master order is filled.
They are mostly used to create a “bracket” around open position, so they are called brackets. However, user can
enable only one part of bracket (Stop or Limit)

When Bracket checkbox of corresponding price is checked, order would be sent as bracketed order. However, if
order is closing or reducing existing open position, it would not be sent as bracket.

Factors are price difference between bracket orders and master order

When user is moving mouse pointer over the order entry area, places for bracket orders are indicated on the
opposing side in orange, and prices also highlighted (see picture).

If market bracket order is sent, bracket prices are determined against current bid/ask price.
If both Limit and Stop checkbox are checked, linked orders will be sent as OCO order pair.

If only Stop is checked, it is possible to send linked Trailing Stop order (by checking Trailing Stop checkbox also).
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Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Buy Bracket

Click on the Buy Bracket Box to activate the
option of placing a BUY Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Sell Limit

If sell LMT is checked then the bracket will have
the Sell LMT side attached being placed above
the market on the opposite side of the Buy
Bracket

This factor indicates how far from the BUY order
the Sell LMT will be

Sell Stop

If sell STP is checked the bracket will have the
Sell STP leg attached

This indicates where the sell STP will be placed
from the BUY bracket

Sell Bracket

Click on the Sell Bracket Box to activate the
option of placing a SELL Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Buy Stop

If buy STP is checked then the bracket will have
the buy STP leg attached being placed above the
MKT on the opposite side of the Sell Bracket

This factor indicates how far from the Sell order
the Buy STP will be bracketed

Buy Limit

If buy LMT is checked the bracket will have the
Buy LMT leg attached be placed beloved the MKT
on the opposite side of the initial trade

This indicates where the sell STP will be placed
from the BUY bracket
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#

2DNR: Two-day range (high-low) that is narrower than any two day range in the preceding 20 days.

3Day: The 3-day market pattern as described in “The Taylor Trading Technique by George Douglass Taylor. B=Buy, S=Sell,
SS=Short Sale.

3DNR: Three-day range (high-low) that is narrower than any three day range in the preceding 20 days.

A

Account balance: The amount of money or debt in an account.

Account Number: (1) A series of characters (alpha and/or numeric) used to identify a customer account or relationship. (2) The
remitting financial institution's account serviced by the receiving bank. (3) The identification assigned by a financial
institution often called the account number.

Account position: The balance and current holdings of an account.

Ask: An indication by a trader or a dealer of a willingness to sell a security, a futures, or other financial instrument. The price at which
an investor can buy. Syn. offer. See also bid; quotation.

Asked: The price that someone is willing to accept for a security, futures or other financial instrument. The ask portion of a quote is
the lowest price anyone is willing to accept at that time.

Asked Price: The price at which sellers offer securities, futures or other financial instrument to buyers. Also called offer price.

At-the-money: An option with a strike price equal to the current price of the instrument, such as a stock, upon which the option was
granted.

At-the-opening order: An order that specifies it is to be executed at the opening of the market or of trading or else it is to be
canceled. The order does not have to be executed at the opening price, but within the opening range of prices.

At or better: (1) In a buy order for securities, futures or other financial instruments it is purchasing at the specified price or under it
(2) For a sell order, it is selling at the specified price or above it. See limit order

B

Bear Market (bear/bearish): A market in which prices are declining. A trader who believes prices will move lower is called a
“bear.” A period of generally failing prices and pessimistic attitudes.

Beta: A measure of an investment's volatility. The lower the beta, the less risky the investment.
Bid: An indication of a trader of a willingness to buy a security. The price at which an investor can sell.
Bid-offer spread: The difference between the bid price and the offer price.

Break-even point: (1) The point at which gains equal losses. (2) The price a market must reach for an option buyer to avoid a loss if
he exercises. For a call, it is the strike price plus the premium paid. For a put, it is the strike price minus the premium paid.

Broker: An individual or firm that charges a fee or commission for executing buy and sell orders placed by another individual or firm,
floor broker in commodities futures trading, a person who actually executes orders on the trading floor of an exchange; an
account executive (associated person) as the person who deals with customers and their orders in commission house
offices.

Buy Limit order: An order to a broker to buy a specified quantity of a security at or below a specified price (called the limit price).

Buy on close: Buying securities, futures or other financial instruments at the end of a trading session at a price within the closing
range.

Buy on opening: Buying securities, futures or other financial instruments at the beginning of a trading session at a price within the
opening range.

Buy Stop Order: An order to buy a market that is entered at a price above the current offering price and that is triggered when the
market price touches or goes through the buy stop price.

Buying Hedge (or Long Hedge): Buying futures contracts (or other financial instruments) to protect against possible increased cost
of inputs slated for futures uses. See Hedging.
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C

Closing balance: The balance of entries posted to the account at the close of the statement period.

Closing price: The price at which transactions are made just before the close on a given day. A number of transactions are often made
at this time and they will be included over a range of prices. See also closing range.

Commission: (1) A fee charged by a broker to a customer for performance of a specific duty, such as the buying or selling of futures
contracts. Banks charge commissions for issuing letters of credit, accepting drafts drawn under letters of credit, entering
foreign exchange transactions for their customers, custodial services, acting as fiscal agent, etc. Fees are paid by banks to
others for various services and include fees to foreign exchange brokers for arranging foreign exchange transactions. A
commission must be fair and reasonable, considering all the relevant factors of the transaction. (2) Sometimes used to refer
to the Commodity Futures Trading Commission (CFTC).

Commodity: An entity of trade or commerce, services, or rights in which contracts for future delivery may be traded. Some of the
contracts currently traded are wheat, corn, cotton, livestock, copper, gold, silver, oil, propane, plywood, currencies,
Treasury Bills, Treasury Bonds, and Stock Indexes.

Contract Month: The month in which deliveries to be made in accordance with a futures contract.

D

Day Trade: The purchase and sale of a futures or an options contract in the same day, thus ending the day with no established
position in the market or being flat.

Delivery Month: A calendar month during which a futures or options contract matures and becomes deliverable.

F

FOK (Fill or Kill): FOK (Fill or Kill) When an order is given to a broker that must immediately be filled in its entirety or, if this is
not possible, totally canceled.

G

GTC (Good until cancelled): GTC (Good until cancelled) orders are generally held on file and considered to be active unless
cancelled by you. Upon expiration of the contract, the GTC order will be automatically cancelled.

Initial Margin: The minimum value on deposit in your account to establish a new futures or options position, or to add to an existing
position. Initial margin amount levels differ by contract. Brokerage firms set the level of Initial Margin required, and it may
change at any time at their discretion. Increases or decreases in Initial Margin levels reflect anticipated or actual changes in
market volatility. Also called "Initial Performance Bond." (See also Margin)

Intrinsic Value: The absolute value of the in the money amount; that is, the amount that would be realized if an in the money option
were exercised.

10C (Immediate or Cancel): IOC (Immediate or Cancel). An order requiring that all or part of the order be executed immediately
after it has been brought to the market. Any portions not executed immediately are automatically cancelled. This is used for
large orders where filling quickly can be difficult.

L

Leverage: Essentially, it allows an investor to establish a position in the marketplace by depositing funds that are less than the value
of the contract. The use of borrowed assets by a business to enhance the return to the owner's equity.

Limit Order: An order in which the customer sets a limit on either price or time of execution, or both, as contrasted with a market
order, which implies that the order should be filled at the most favorable price as soon as possible.

M

Margin Call: A call from a brokerage firm to a customer to bring margin deposits back up to minimum levels required by exchange
regulations; similarly, a request by the clearinghouse to a clearing member firm to make additional deposits to bring
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clearing margins back to minimum levels required by clearinghouse rules. A demand upon an investor to put up more
collateral for securities bought on credit.

Market If Touched Order: An order which becomes a market order if the specified price is reached.

Market Inversion Index (MI1): Market Inversion Index. A very short term momentum indicator. This indicator is used to determine
which side of the market to be on for the close and early session the following day. When the Ml flips from, for instance,
long to short on the market close, a trader should go short with the intent of covering the short either in globex or early in
the next day’s session. This is a short term indicator for aggressive traders.

Market On Close Order: A buy or sell order which is to be executed as a market order as close as possible to the end of the day.

Market Order: An order to buy or sell futures contracts, stocks or other financial instrument which is to be filled at the best possible
price and as soon as possible. A limit order, in contrast, may specify requirements for price or time of execution.

Moving Average: A mathematical procedure to smooth or eliminate the fluctuations in data. Moving averages emphasize the
direction of a trend, confirm trend reversals, and smooth out price and volume fluctuations or “noise” that can confuse
interpretation of the market.

N

Net position: (1) A financial institution has a position in foreign currency when its assets, including future contracts to purchase, and
liabilities, including future contracts to sell, in that currency are not equal. An excess of assets over liabilities is called a net
"long" position and liabilities in excess of assets result in a net “short" position. A long net position in a currency which is
depreciating results in a loss, because with each day, that position (asset) is convertible into fewer units of local currency.
A short position in a currency which is appreciating represents a loss, because with each day, satisfaction of that position
(liability) costs more units of local currency. (2) The difference between the open long (buy) contracts and the open short
(sell) contracts held by any one entity in any one futures contract month or in all months combined.

R

Round Turn: The combination of an initiating purchase or sale of a futures contract or other financial instrument and offsetting sale
or purchase of an equal number of futures contracts or other financial instruments, of the same specifications. Commissions
and fees for transactions are charged on the round turn.

S

Sell Limit order: An order to a broker to sell a specified quantity of a security at or above a specified price (called the limit price).

Stop Limit Order: An order to buy or sell a certain quantity of a certain security at a specified price or better, but only after a
specified price has been reached. Essentially a combination of a stop order and a limit order.

Stop Loss: A risk management technique used to close out a losing position at a given point. A stop loss order is placed at the given
point.

Strike price: A specified price at which an investor can buy or sell an option's underlying financial instrument. The exchange rate,
interest rate, or market price that is guaranteed by an option transaction.

Symbol: Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade futures
contracts
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